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Network Analysis and Visualization"
Tutorial for Digital Arts and Humanities Scholars
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Software, Datasets, Plugins, and Documentation
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» 'These slides
http://ivl.slis.indiana.edu/km/pres/2012-borner-sci2tutorial-meertens.pdf
» Sci2 Tool Manual v0.5.1 Alpha
http://sci2.wiki.cns.iu.edu
» Sci2 Tool v0.5.1 Alpha (May 4, 2011)

http://sci2.cns.iu.edu

» Additional Datasets
http://sci2.wiki.cns.iu.edu/2.5+Sample+Datasets
» Additional Plugins
http://sci2.wiki.cns.iu.edu/3.2+ Additional+Plugins

Or copy them from the DVD or memory stick.




° : Tutorial Overview

12:30p Welcome and Overview of Tutorial and Attendees
12:45p Plug-and-Play Macroscopes, OSGi/CIShell Powered Tools
1:00p Sci2 Tool Basics
» Download and run the Sci2 Tool
» Load, analyze, and visualize family and business networks
»  Studying four major network science researchers
- Load and clean a dataset; process raw data into networks
- Find basic statistics and run various algorithms over the network
- Visualize as either a circular hierarchy or network
2:30p Break
3:00p Sci2 Tool Novel Functionality
» Yahoo! Geocoder
» Evolving collaboration networks
> R-Bridge
4:00p Outlook and Q&A
4:30 Adjourn
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Using the Sci2 Tool to Visualize Tutorial Registrants

Use File > Read’ to load cleaned Sci2TutorialRegistrants.csv

A B

1 Affiliation Background
2 RU Geography,Science & Technology Studies Affiliation H#
3 EUR Cultural History CWI 1
4 EUR SOCEOIOgY CWTS 1
5 Huygens Historical Disciplines DANS 1
6 Meertens Computational Musicology e-Humanities Group 1
7 LeidenU Religious Studies,Semitic Languages EUR 3
8 UVA Sociology Fluygens 5
Leiden U 2
Total of 26 (max #) registrants on Oct 10, 2011. Meertens 3
Main affiliations are shown to the right. Sfj;dljt?oilwll\?jtg;ork 1
RU 1
Utwente 1
[8]8) 1
UVA 2
VU 6
Grand Total 26
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“il  Using the Sci2 Tool to Visualize Tutorial Registrants

Use File > Read’ to load cleaned Sci2TutorialRegistrants.cs

A B
1 Affiliation Background
2 RU Geography,Science & Technology Studies -
3 [EUR Cultural History W7 Sci2 Tool
4 EUR Sociology File (DstsPreparation | Preprocessing Analysis 1
5 Huygens Historical Disciplines (=] 'i Remove ISl Duplicate Records
6 Meertens Computational Musicology [Welc Remove Rows with Multitudinous Fields
7 LeidenU Rell.gllous Studies,Semitic Languages :&i:l Ea e Deead ot
i
SHUVA Soa0oky igaﬁ Extract Bipartite Network
Run ‘Data Preparation > Extract Bipartite Network® — ltore Bt PaperCitation Network

With parameter values: x|

Extract a bipartite network from two columns in the table. If the column
values may kst multiple entries, enter the spedal text which delimits
them.

First column |Affiation = 3’
Second column |Background | 2]
Text Delimiter I i,

Visualize resulting Bipartite network from Affiliation to Background’ using ‘1 isualization >
Network > GUESS” and Layout > GEM’, Layout > Bin Pack’




Sci2 Tool — Visualize Tutorial Attendees:
Bi-partite Affiliation-Background Network

OCampul.anmal Musicology

n +0 Literary Studies

S —+O social Sciences
™~ - m : Oa_csmu & Technology Studies
Q Semantic Web b
OMBCIGDE | . IOPdih‘rd Science O Geography

Orriysics - ) O Religious Studies /N
'OCnmmIer Science y .
| O semiic Languages ¢ O Historical Discipines
OEnvironmental Science {
. O Humanities Computing
O commurication
m *Olinformation Retrieval u
O scientometrics
A O_Des-gn
Oeitlometrics \ X
T OHel o Ve,
Uva ; Technical Scientific Programmer
s k ’ O5ysluns Librarian
0'\ el - +O Adaptive Ui

Eur +O Digital Humanities \
O nformation Visualization

B Main Affiliation
(O Background

O cultural History

Object: |nodes based on -> | w| Property: |bipartitetype w| Operator: [1= w| Value: |Background |v|
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&

. ]

GC_, Use t Learn
5 1 0(
gpractices fy

Get to know new tools to attach to our university repository
software

familiarity visualisat]

actuals '2
e e2Cle

hS o . : i :
. A basic understanding of the possibilities of the Sc2 tool in
presentingy § T e .
5 o O g particular in e-humanities researc
spatialy € “9 | )C¢

o 0_ = | Priciples behing the development and use of 5ci2, so that | will

stimulates 8DOSSIDI[IU_ be able to decide whether they (probably the principles, rather
=

g ana[gzin\é than the program itself), are also applicable to my own field of
] mUCh 9) Digital Philology.

8 evolut| which research questions can be addressed (advantages and
G- disadvantages) - insights in how to prepare data for analysis -
t&; examples on how visualizations can be interpreted

How to interface the tool with other systems, technical details
of the software. How we can collaborate with Sci2 and
BibServer/BibSoup




Q= Tutorial Overview

12:45p Plug-and-Play Macroscopes, OSGi/CIShell Powered Tools
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Borner, Katy. (March 2011).

Plug-and-Play Macroscopes.
Plug and-PI ay Communications of the ACM,
Macroscopes JEKENICAS

. by Katy Borner
W\

Video and paper are at




Plug-and-Play

Macroscopes

Take terra bytes of data

Identity trends

Macroscopes

Decision making in science, industry, and politics, as well as in daily life, requires
that we make sense of data sets representing the structure and dynamics of
complex systems. Macroscopes provide a “vision of the whole,” helping us
“synthesize” the related elements and enabling us to detect patterns, trends, and
outliers while granting access to myriad details. Rather than make things larger or

smaller, Macroscopes let us observe what is at once
too great, slow, or complex for the human eye
and mind to notice and comprehend.

)
'

Microscopes Telescopes Macroscopes
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Plug-and-Play Macroscopes

While microscopes and telescopes are physical instruments,
macroscopes resemble COﬂtiflUOUSly Changing bundles of

software plug-ins. Macroscopes make it easy to select and combine

algorithm and tool plug-ins but also interface plug-ins, workflow support, logging,
scheduling, and other plug-ins needed for scientifically rigorous yet effective work.

They make it easy to share plug-ins via email, flash drives, or online. To use new
plugins, simply copy the files into the plug-in directory, and they appear in the tool

menu ready for use. No restart of the tool is necessary. Sharlng
algorithm components, tools, or novel
interfaces becomes as easy as sharing images
on Flickr or videos on YouTube. Assembling
custom tools is as quick as compiling your
custom music collection.
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}ggg(: | OSGi & Cyberinfrastructure Shell (CIShell)

» CIShell (http://cishell.org) is an open soutce softwate specification for the integration
and utilization of datasets, algorithms, and tools.

» It extends the Open Setrvices Gateway Initiative (OSGi) (http://osgi.org), a

standardized, component oriented, computing environment for networked services

widely used in industry since more than 10 years.

» Specifically, CIShell provides “sockets” into which existing and new datasets,
algorithms, and tools can be plugged using a wizard-driven process.

Developers _ Users
S B & Sk 5
Jféj 0 Mﬂ% HE‘& 'ﬁéj “f‘i"%
= i ;';;;;;;ﬁ” A
v Alg . i : 4‘ Workflow
Tool ' A 0SGi NNWE Tool Workflow
Tool | Workflow

@ -
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‘ggg(: |SHelll osGi/cishell-Powered Tools Support Algorithm Sharing

Different datasets/formats.
Diverse algorithms/tools written in
many programming languages.

CS

Bio
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Tutorial Overview

12:30p Welcome and Overview of Tutorial and Attendees
12:45p Plug-and-Play Macroscopes, OSGi/CIShell Powered Tools
1:00p Sci2 Tool Basics
» Download and run the Sci2 Tool
» Load, analyze, and visualize family and business networks
» Studying four major network science researchers
- Load and clean a dataset; process raw data into networks
- Find basic statistics and run various algorithms over the network
- Visualize as either a circular hierarchy or network
2:30p Break
3:00p Sci2 Tool Novel Functionality
» Yahoo! Geocoder
> Evolving collaboration networks
> R-Bridge
4:00p Outlook and Q&A
4:30 Adjourn
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Science of Science (Sci2) Tool
http://sci2.cns.iu.edu

» Explicitly designed for SoS research and practice, well documented, easy to use.

» Empowers many to run common studies while making it easy for exports to
perform novel research.
» Advanced algorithms, effective visualizations, and many (standard) workflows.
» Supports micro-level documentation and replication of studies.
> Is open soutce—anybody can review and extend the code, or use it for
commercial purposes.
SUMMARY
o Existing metrics have known flaws
nature e Areliable, open, joined-up data L Do LR

infrastructure is needed

o Data should be collected on the full
O P | N | O N range of scientists’ work
e Social scientists and economists
should be involved

Let's make science metrics more scientific

To capture the essence of good science, stakeholders must combine forces to create an open, sound and
consistent system for measuring all the activities that make up academic productivity, says Julia Lane.
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Sci? Tool — “Open Code for S&T Assessment”

Joint Co-Authorship Network

OSGi/CIShell poweted tool with NWB plugins and
many new scientometrics and visualizations plugins.
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D Sk B Sci Maps GUESS Network Vis

Horizontal Time Graphs

Bérner, Katy, Huang, Weixia (Bonnie), Linnemeier, Micah, Dubon, Russell Jackson, Phillips, Patrick, Ma, Nianli, Zoss,
Angela, Guo, Hanning & Price, Mark. (2009). Rete-Netzwerk-Red: Analyzing and Visnalizing Scholarly Networks
Using the Scholarly Database and the Network Workbench Tool. Proceedings of ISST 2009: 121h International Conference
on Scientometrics and Informetrics, Rio de Janeiro, Brazil, July 14-17 . V'ol. 2, pp. 619-630.

20
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Help

Welcome to the Science of Science Tool (Sci
The developrment of this tool is supported in
| Network Science center and the School of Li
{Indiana University, the National Science Fou
and [5-0715303, and the James 5. McDonnel
Cyberinfrastructure portal (http:fisci.slis.ind

The primary investigators are Katy Bomer, In
SciTech Strategies Inc. The Sci’ tool was dewy
J. Duhon, Patrick A Phillips, Chintan Tank, 2
Cyberinfrastructure Shell (http:f/cishell.org)
for Network Science Center (http:ffens.slis.ii
Many algorithm plugins were derved from ¢
(http:finwhb.slis.indiana.edu).

Please cite as follows:
Sci® Team, (2009). Science of Science Tool. Ir
| Strategies Inc., http:fiscislis.indiana.edu.

GUESS
GnuPlot

Radial Tree/Graph (prefuse alpha)

Radial Tree/Graph with Annotation (prefuse beta)
Tree View (prefuse beta)

Tree Map (prefuse beta)

Force Directed with Annotation (prefuse beta)

Fruck Reingold with Annotation (prefi
Drl (VixOrd)
Specified (prefuse beta)

Horizontal Line Graph

Circular Hierarchy

Geo Map (circle annotations)

beta)

2 Schedulel| Geo Map (region coloning annotations)
Reftapper
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Type of Analysis vs. Level of Analysis

Micro/Individual
(2-100 records)

Meso/Local
(101-10,000 records)

Macro/Global

Statistical
Analysis/Profiling

Temporal Analysis
(When)

Geospatial Analysis
(Where)

(10,000 < records)

>

= | L o %
Topical Analysis |~ i : f’r B2
(What) - = E D
Network Analysis b )
(With Whom?) ) =X

e (RS-
éo';""...

21

Type of Analysis vs. Level of Analysis
Covered Today:

Micro/Individual
(2-100 records)

Meso/Local
(101-10,000 records)

Macro/Global
(10,000 < records)

Statistical
Analysis/Profiling

Temporal Analysis
(When)

Geospatial Analysis
(Where)

Topical Analysis
(What)

Network Analysis
(With Whom?)

22




Sci? Tool — Supported Data Formats

Input:
Network Formats

»  GraphML (*.xml or *.graphml)

»  XGMML (*.xml)
»  Pajek NET (*.net)
» NWB (*.nwb)
Scientometric Formats
IST (*.isi)
Bibtex (*.bib)

Scopus csv (*.scopus)
NSF csv (*.nsf)
Other Formats
> Pajek Matrix (*.mat)
» TreeML (*.xml)
> Edgelist (*.edge)
» CSV (*.csv)

Formats are documented at http:

» Endnote Export Format (*.enw)

Output:

Network File Formats

GraphML (*.xml or *.graphml)
Pajek .MAT (*.mat)

Pajek NET (*.net)

NWB (*.awb)

XGMML (*.xml)

CSV (*.csv)

VVVYVYVY

Image Formats

> JPEG (“jpg)
» PDF (*.pdf)

> PostScript (*.ps)

sci2.wiki.cns.iu.edu/display/SCI2ZTUTORIAL/2.3+Data+Formats.

23

Sci? Tool — Supported Tools

1B gepdot graph
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Gnuplot

portable command-line driven

interactive data and function plotting

utility http:

www.gnuplot.info/.

GUESS

exploratory data analysis and visualization tool
for graphs and networks.

https://nwb.slis.indiana.edu/community/?Pn=Vi
sualizeData. GUESS.
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Sci2 Tool v0.5.1 Alpha (May 4, 2011)

Can be freely downloaded for all major
operating systems from

http://sci2.cns.iv.edu
AMthmmim

Select your operating system from the = s —
e —
pull down menu and download.

Unpack into a /sci2 directory. L—
T mosver your accoune pavemond, pleae vt our simard 100121 g
Run /sci2/sci2.exe S
Sci2 Manual is at :..;‘;.:_}“.‘:;"’“m:“ s T s
http://sci2.wiki.cns.iu.edu REL ST O T b e ot S oy Bt
. Phowse chre 0
Cite as O et ) T e ot ek g et i

Arknentrdgrments

Sei? Team. (2009). Science of Science (Sci’) Tool. B wwumeeren s

Indiana University and Scilech Strategies,

htth:/ [ sci2.cns.in.edn e T

Sci? Tool: Download, Install, and Run

Sci2 Tool v0.5 Alpha (May 4, 2011)

Supports ASCII UTF-8 characters
Web-based Yahoo! and desktop Geocoders
U.S. and World geomapper

Customizable stop word lists ; ;
1) 5¢i2-N-1.0.0.201008130505NGT-macosx.carbon.ppc.zip

Merging of networks 1) 5ci2-N-10.0.201008130505NGT-macosx.carbon 6. zip
New home page, wiki-based tutorial 1 sci2-N-10.0.201008130505NGT-macosx.cocoax86_64.zip
1) 5¢i2-N-1.0.0.201008130505NGT-win32.win32.86.zip

YV VVYYVYY

Bug fixes, streamlined workflows

Sci2 Tool runs on Windows, Mac, and Linux.

Unzip. ] sciz-N-11 T _ [ a3k
. . B sci2 | Browse with Corel Paint Shop Pro Photo X2
Run /SC12/ sci2.exe Open Command Prompt Here
Extract All...

Scan for Viruses...

1-Zip > Open archive
Open With... Extract files...
3 MagiclsO » Extract Here

26




Sci2 Tool Interface Components
See also http:/ [ sci2.wiki.cns.in.edu/ 2.2+ User+Interface

Use . File om paration  Preprocessing  Analysis  Modeling jon - Help
W nsole] =0 Lmoaiinl.\.ﬂanager- D
> Menu to read data) run Welcome to the Science of Science Tool (Sei). - G Directory Tree - Prefs
1 ith Lhe:wmk'k wr:m:lu:’ Sehe wi"ﬁ"""ﬁ’?«' Lw'_s: » :;'m e
a gorl ms. Unheersity, u:!‘h:i:l:nm:;nen::l‘nu:dabun unzr.ﬁrlm ;a SB:“ﬂ?}‘;L‘IE‘:a:H - L3
lls ms;na and th:]amcsS.M:Donn:lI Foundthm See Science of Science
» Console to see work log, pocal bty o ormar
. anm_rmv::hgmn_m Katy Bamer, Indiana University and Kevin W. Boyack, SciTech
references to Semlnal Works. Strategies Inc. The Scif tool was developed by Micah W. Linnemeier, Russell ), Duhon,
e i Sl o e el -
» Data Manager to sclect, view, | @swewer = =0
save loaded, simulated, or B o cinh .
derived datasets.
! Algorithm Name Date Time % Compl
» Scheduler to see status of B Rend Duectary Hiearchy. | SIS0 021PM .
. . o — m— b S
algorithm execution. : o ———

All wotkflows are recorded into a log file (see /sci2/logs/...), and soon can be re-
run for easy replication. If errors occur, they are saved in a error log to ease bug
reporting,

All algorithms are documented online; workflows are given in tutorials, see Sci2
Manual at http://sci2.wiki.cns.iu.edu
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Tutorial Overview

12:30p Welcome and Overview of Tutorial and Attendees
12:45p Plug-and-Play Macroscopes, OSGi/CIShell Powered Tools
1:00p Sci2 Tool Basics
» Download and run the Sci2 Tool
» Load, analyze, and visualize family and business networks
» Studying four major network science researchers
- Load and clean a dataset; process raw data into networks
- Find basic statistics and run various algorithms over the network
- Visualize as either a circular hierarchy or network
2:30p Break
3:00p Sci2 Tool Novel Functionality
» Yahoo! Geocoder
> Evolving collaboration networks
> R-Bridge
4:00p Outlook and Q&A
4:30 Adjourn
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Padgett's Florentine Families — Load, analyze, and
visualize family and business networks

Florentine families related through business ties (specifically, recorded financial ties such
as loans, credits and joint partnerships) and marriage alliances.

Node attributes
» Wealth: Each family's net wealth in 1427 (in thousands of lita).
» Priorates: The number of seats on the civic council held between 1282-1344.
» Totalities: Number of business/marriage ties in complete dataset of 116 families.
Edge attributes:
» Matriage T/F
» Business T/F

“Substantively, the data include families who were locked in a struggle for political
control of the city of Florence around 1430. Two factions were dominant in this
struggle: one revolved around the infamous Medicis, the other around the powerful
Strozzis.”

More info is at http://svitsrv25.epfl.ch/R-doc/library/ergm/html/florentine.html
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Padgett's Florentine Families — Load, analyze, and
visualize family and business networks

*Nodes

. - id*int label*string wealth*int totalities*int
Florentine families related through E priorates*int es such

as loans, credits and joint partnershij 1 "Acciaiuoli” 10 2 53
. 2 "Albizzi" 36 3 65
Node attributes 3 "Barbadori" 55 14 0

. ! 4 "Bischeri" 44 9 12
» Wealth: Each family's net wealt & "Castellani® 20 18 22

» Priorates: The number of seats ¢ 6 "Ginori" 329 0
7 "Guadagni" 8 14 21

» ‘'Totalities: Number of business/| 8 "Lamberteschi" 42 14 0 lies.
) _ 9 "Medici" 103 54 53
Edge attributes: 10 "Pazzi® 48 7 0
> Marri 11 "Peruzzi" 49 32 42
arriage T/F 12 "Pucci" 310
» Business T/F 13 "Ridolfi" 27 4 38

14 "Salviati" 10 5 35

. . 15 "Strozzi" 146 29 74
“Substantively, the data include fami ;g “Tormabuoni* 48 7 0 |

control of the city of Florence arour *UndirectedEdges

.| source*int target*int marriage*string business*strin
struggle: one revolved around the in &) ope 9 9 g 9 Ful

Strozzis.” 6 2 "T" "E"

i ) . 72T E"
More info is at http://svitsrv25.epfl] g o wpn e

53" "T"

=
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Padgett's Florentine Families — Load, compute
basic network properties & view in GUESS

> Load *yoursci2directory*/ sampledata/ socialscience/ florentine.nwb
» Run Analysis > Network Analysis Toolkit (NAT)’ to get basic properties.

This graph claims to be undirected.

Nodes: 16

Isolated nodes: 1

Node attributes present: label, wealth, totalities, priorates
Edges: 27

No self loops were discovered.

No patallel edges were discovered.

Edge attributes:

Nonnumeric attributes:

Example value

marriag... T

busines...FF

Average degree: 3.375

There are 2 weakly connected components. (1 isolates)
The largest connected component consists of 15 nodes.
Did not calculate strong connectedness because this graph was not directed.
Density (disregarding weights): 0.225

» Select network and run Visualization > GUESS’ to open GUESS with file loaded.

» Apply ‘Layout > GEM’.
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=18l
B2 cConsole il =l Tists Mansg i
......... | ' NWB File: C:\Documents and Settingsijaty\C
:-Erif F;sisetm:g;, T Dustribution of degree for network at st
uthor(s): Eytan L.
hmplementen(s): Eytan Adar (GLESS), Russell Duhon (resizetinear, colrizs fix) o List of edges of network created through the
nkegraton(s): Russell Dubon " Dustribution of degree for network at sh,
Feference: Adar, Eytan, "GUESS: A Language and Interface For Graph Exploration,” CHI 2006 (http:/ /graphexploration.cond.org/) Ml Distribution of degres for network at st
Eﬁ:;-:r;?t-on https://nwh.slis.indiana.edu/community, 7n =VisualizeDat 2. GUESS B2 W fie: C:\Documents and Settingslkatyc
Etarting GLESS. .. = Graph and Network Analysis Log
ECHO is off. = Sequence of site betwesnnesses for o
El‘:f;\ilddl?ymt For your visuskzation is random., For a clearer visuakzation, please run & Layout from the Layout menu. (We recommend GEM, ) A Distribution of sibs batwesnness for nat
e . oA
5LESS log file for this session can be found in = Dctribution of ke betweennass for naty
C:\DOCUME 1 Jraty|\LOCALS~1\Temp|C1Shel- S5O9Z1StaticE xecut SSR04ALGORT guession tat '+ NWE file with site betweennass attribute
eSS was selected Visualization - GUESS =10] x|
puthor(s) Extan Adee | Fle Edt Layot Sopt Vew Heb
{s): Eytan Ad
Inbegraton(s): Russell Dubs k- |
B e araas A, Evtan - Medici-Acciaiuoli
Pocumentation: https: i Field Vahe |
ECHO i off. __edgesd o
Starting GUESS. .. Business F
ECHO is off. coior darvdoion
[The: indtial lavout For your +
ECHO is off, 5 (drected False
SUESS log File For this sess| .5 label
KA DOCUME~1 Yty \LOCA labelcolor 0,0,0,255
Labelsize 12
B scheduler Isbelvisble False
narriage T
Remove FromList [ [ | odel e
node2 nl
m visible true
weight 1o
2
[ltr| ™20
GUESS
GLESS
| Node Betw
| Metwork Az
¥ Load...
. GraPlot
GraPlot
J 2 Obrect: | Property: = | Operator: = | Yahue:
¥ Degree Dis -
J il Eurabiie Colour Show Hde Size Show Label Hide Label Change Label
7 Gralot | J | | |
o Degree i Node Shape Center || Change History
| GUESS
| Load...
Interpreter | Graph Modifier
| K | 32




Lg% Pan:

Fie Edt Layout Script View Help | “orab” the background
Medici : by holding left-click
Field || Value ' and moving your

g ;::1 ;.:;:Iu... g O mouse. i
height  10.0
image

‘g lsbel  Medii N O Zoom:
m ?'20'0"” b A Using scroll wheel,
oo, e ﬁ U press the “+” and “-”
origingl... Medici O buttons in the upper-
priorates 53 /’) left hand corner, or
f:: ;"”’b @] < right-click and move
totalties 54 the mouse left or right.
o e m Center graph by
width  10.0 selecting “View ->
X 90.625... Centet’.
y 44.312... m m

S
i " Select /g to
select/move single

Object: [ ‘_'J Property: [Ia-tels-:: "'] Operator: [E} Value: EI nodes. Hold down
| coour || show |[ Hde || see || showiabel || Hidersbel || changelabel | ‘Shift’ to select
| Format Node Labels | | Format Edge Labels | multiple.
| Modeshape || center || changetistory | ' . .
| ] Right click to modify
Color, etc.
[Nodes | [labetsize =] From: | | To: | || Do Resize Linear
Interpreter , Graph Modfier |
33
Graph Modifier:
Visualization - GUESS ‘Jm—IK
| Select “all nodes” in the Object
T drop-down menu and click ‘Show
rod | vae || G Label’ button.
color  255,25... -
ed  False 3
height 5.0 a (x_.-’ ani;) . -~ . .
gmw . W e Select ‘Resize Linear > Nodes >
kel pucd l'h'} ' Baradort] h lities” d d th
Isbelcolor ?,zo,o,.. o Lamb b ponzzt) = @) — totalities rop-down menu, then
labebv... true E W altizzi) type “5” and “20” into the From”
name  nl2 - rezzi Y 2
. P O e Strazz b - ;. and To Valtle box sleparz?tely. ’
srcha... cadeb.. @ W ouior) Medtl) Then select ‘Do Resize Linear’.
2 - -
’::m 1 (O romataony 2 Actiaiuok)
=HE m Select ‘Colotize>
pah_ 52 Nodes>totalities’, then select
P10 m O Pueci) white and enter (204,0,51) in the
pop-up color boxes on in the
Ay “From” and “To” buttons.
Object: | [«] Property: [heie =) Operator: [~ ~| vahue: [ =
: Select “Format Node Labels”,
| coor || show || mde |[ see || showisbel || mdetsbel || chenotabel | lace defaul oinallabel
P | ] replace default text {orlglna abel}
with your own label in the pop-up
| Nodeshzpe || cCenter || chengetstory | box Fnter a f tine strino f
= = : 1
st OX ner? ormatting string for
node labels.
Interpreter | Graph Modfier |
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Visualization - GUESS _dm_!.[
He Edt lwost Sapt Yew Hebp |

Acciaiuoli:) ﬂ
Field | Value
color  255,24...
false
height  5.6635...
wnage

labeicolor 0,0,0,...
labelsize 12
name nl
priorates 53
style 2
totalities 2
visible true
wealth 10
width  5.6635...
x 112.01...
¥ 70.315...

O Castellani)
O ’ O BarbauQ Sl
Lamb SHeseN)

Peruzzi) O Salviati:)
O avizziy

Strczzib ( )
Ridaif) . Pazzi)
O Medici:)

Guadagni)

O Tomabuoni:) O Acciaivoi)

O Bischeri)

O Pucei) Interpreter:

Uses Jython a combination of Java
and Python.

BEEBEEOE 00

>5>> resizelinear(totalities,5,20)
=55 colorize{wealth,white,red) Try
>>>
colorize(wealth, white, red)

| Interpreter  Graph Modfier |
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Tutorial Overview

12:30p Welcome and Overview of Tutorial and Attendees
12:45p Plug-and-Play Macroscopes, OSGi/CIShell Powered Tools
1:00p Sci2 Tool Basics
» Download and run the Sci2 Tool
» Load, analyze, and visualize family and business networks
»  Studying four major network science researchers
- Load and clean a dataset; process raw data into networks
- Find basic statistics and run various algorithms over the network
- Visualize as either a circular hierarchy or network
2:30p Break
3:00p Sci2 Tool Novel Functionality
» Yahoo! Geocoder
> Evolving collaboration networks
> R-Bridge
4:00p Outlook and Q&A
4:30 Adjourn
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Studying Four Major NetSci Researchers (ISI Data)
using Database (section 5.1.4)

FourNetSciResearchers.isi

Time frame: 1955-2007

Region(s): Miscellaneous

Topical Area(s): | Network Science

Analysis Type(s): Paper Citation Network, Co-Author Network, Bibliographic

Coupling Network, Document Co-Citation Network, Word Co-
Occurrence Network

Thomson Reuter’s Web of Knowledge (WoS) is a leading citation database. Access it
via the “Web of Science” tab at http://www.isiknowledge.com (note: access to this
database requires a paid subscription). Along with Scopus, WoS provides some of
the most comprehensive datasets for scientometric analysis.

To find all publications by an author, search for the last name and the first initial
followed by an asterisk in the author field.

bttp:/ [ sci2. wiki.cns.in.edu/ 5. 1.4+8 tudying+Four+Major+NetS ci+Researchers+ (1514 Data)
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Data Acquisition from Web of Science

.-.I.Iil!.l'
In Dec 2007, we downloaded e RO N RN e — ﬁ,9|
T e — B e oemoe - [P v 1

all papers by

o) Mo T | 7 10 s o i [VL0)
1S Web of Knowledge™

> Eugene Garﬁeld Web of Science® ol
(o || ] OSSR e | | SR

» Stanley Wasserman P — P—
Select dotabase{s) and thmespan: “?IM\ -

> Alessandro Vespignani -y damee O DI RN - -, " ol il
F 1 Socil Sciences Citation Indes (S5C1)—~1956-prasent & From [7355 3 to [7507 =] (default is o years)

’ ’ ’ . Fp Arts & Humanities Crtateon Indes (ASHCT)-~1975-present T resmier thats SStHROS 1 =
» Albert-Laszlo Barabasi e

Enter tirms or pheases sepacated by the opraton AND, OF, WOT, o SAME, 4nd than press SEARCH,
The sparch will be added 1o the search history. [ histpry/combine sut5)

from e o

TOPIC: jj Enter one or morw tarms. Seaeches within artichy tites, kayworeds, and abstracts,

& : ol spll® ANO *North Sea® (How 1o search for phrases)
I Tt anly

AUTHMOR: i) Entas one or more author names (see author indes ).
OBALAN C° Of OBAIAN C

 —
EXpaﬁdCd (SCI—EXPANDED) Aythor Fincer: Weed haip finding papers by an suthor? Use Author Finder

GROUP AUTHOR: (i Enter ona or mors Group names (see group author indes 5.
Ex CERN

Vs gur Genaral Search bitonal

ch b

» Science Citation Index

--1955-present
SOURCE TITLE: § Enter full joumal tithes (cee fill source tiles st
Evample: Cancer® OR Journal of Cancer Fesearch and Chncal r_\ncnlwv

» Social Sciences Citation Index

(SSCI)__1956_present wn:sal Enter abbreviated b from thor's affation (use gbrevi _haip}
» Arts & Humanities Citation f

Restnct search by languages and documant types

Index (A&HCI)--1975-present | i e

SEAw0l

nnucum:w YEAR: U Enter & publication year or range.
: 3001 or 1997-1990
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Comparison of Counts
No books and other non-WoS publications are covered.

Age Total # Cites Total # Papers H-Index

Eugene Gartfield 82 1,525 672 31
Stanley Wasserman 122 35 17
Alessandro Vespignani 42 451 101 33
Albert-Laszl6 Barabasi 40 2,218 126 47
41 16,920 159 52
44 30,102 201 68

(Dec 2007)
(Dec 2008)
(April 2011)
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Extract Co-Author Network

Load*yoursci2directory*/ sampledata/ scientometrics/ isi/ FourNetS ciResearchers.isi’
using "File > Load ...*
And file with 361 records appears in the Data Manager.

Duplicates were removed, author names normalized. Log file exists.

% 2 Tool (E==fon ==
File Data Preparation Preprocessing  Analysis  Modeling  Visualzation Help
LConsole = O || it Data Manager =0
|8 Console, g
{Lnaded 361 records. Al m 151 Data: C:\Users\User\Desktop\10-NEH-A&H-Workshop
| Removed 0 duplicate records. [T 361 Unique IS Records

Author names have been normalized.

:|351 records with unique IS 1Ds are available via Data Manager.

'Wrote log to 1

| CAUsers\User\AppDatatLocal\Templisiduplicateremoverlog2534733993422022 — |

3RS =

L 3
B Scheduler =
Remove From List | || Remove completed automatically ..R:mm all complete

!t Algorithm Name Date Time %

¥ Load and Clean I3 File 08/15/2010 07:29:43PM
~ Load and Clean ISI File 08/15/2010 07:12:49PM
‘ m
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Extract Co-Author Network

(see section 5.1.4.2 on correcting duplicate/ misspelled anthor names)

To extract the co-author network, select the 367 Unigue IST Records’ table and run
‘Data Preparation > Extract Co-Author Network’ using isi file format:

_>.<.I
Extracts a co-authorship network From one of several supported file
types.

File Format |isi i &

[

The result is an undirected but weighted network of co-authors in the Data Manager.
Run ‘Analysis > Network > Network Analysis Toolkit (NAT)’ to calculate basic
properties: the network has 247 nodes and 891 edges.

Use ‘Analysis > Network > Unweighted and Undirected > Node Degree’ to calcnlate the number
of neighbors for each node independent of co-anthorship weight.

To view the complete network, select the ‘Extracted Co-Authorship Network’ and run
Visualization > Networks > GUESS".

Network is loaded with random layout. In GUESS, run T.ayout > GEM’ and ‘Layout
> Bin Pack’ to improve layout. Run "Seripr > Run Seript ..." and select '
yoursci2directory/ scripts/ GUESS / co-author-nw.py'.
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Co-Author Network of all Four NetsSci Researchers

~=g Co-Authored
=] 7
. Eugene Garfield 2 :1

(4 1

| — |
1 127 1 3

agerin, A ',‘ Node Size EI\ Colar E,dgr Size &I(_'nlm'
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Co-Author Network of all Four NetsSci Researchers

Use the GUESS Graph Modifier to change
color and size coding.

_E:'m-.:!:_v Wasserman

Calculate node degrees in Sci2 Tool. \ d
. S

Use a graphic program to add legend.

agerin 32 X\ [ 4 Node Sire & Color Eiige Size & Color
L ol Fape \NuiP 1 i

' Eugene Garficld L :—‘

a5
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Individual Co-Author Networks
(Read/map 4 files separately)

Alessandro Vespignani Albert-1.4sz16 Barabasi
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Atool for

o Dl'xiﬂn:t:

Network Visualization:
Node Layout

Load and Clean ISI File was selected.
TLoaded 361 recotrds.

Removed 0 duplicate records.
Author names have been normalized.

Extract Co-Author Network was selected.
Input Parameters:

File Format: isi

Network Analysis Toolkit INAT) was selected.
Nodes: 247

Edges: 891

GUESS was selected.

45
Network Visualization:
Color/Size Coding by Data Attribute Values
-
®
' &% Visualization - GUESS
Ele [Edt Layout Script View Help
Vespignani, A ¢
Field vaeo ||| o

color 125,12,17,255
Fixed false

g height 10,0 °
image .
Iabel Vespignani, A =

~— labelcolor 0,0,0,255 3
ahelei 12 y S . =
labelvisible false T @ Node Size & Color Edge Size & Color
name nlél | ® Number of .‘.li Crs Number of Times
rumberofworks 101 .., Co-Authored
originallabel Vespignand, A » =
strokecolor  black g ., ——| 127 33
e 2 o 35 b4
timescited 3811 4 1
visible true 5
o — M s o
X 586.75
g el B 1 127 1 33




Network Visualization:
Giant Component

Weak Component Clustering was selected.
Implementer(s): Russell Duhon
Integrator(s): Russell Duhon

Input Parameters:
Number of top clusters: 10
3 clusters found, generating graphs for the top 3 clusters.
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Network Visualization:

Color/Size Coding by Degree

Node Degree was selected.
Documentation:

https:/ /nwb.slis.indiana.edu/community/?n=AnalyzeData.No
deDegree

.......... - * . .
. . » .
.
o .
. " - . L] .
.- | 7 . )
—~@ ’ %
Garield E ®
. 4 —y mman, §
. L ]
[ ] .. L ] ® \ .
o \
-] °® * e
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Network Visualization:
Color/Size Coding by Betweeness Centrality

Node Betweenness Centrality was selected. i
Author(s): L. C. Freeman

Implementer(s): Santo Fortunato

Integrator(s): Santo Fortunato, Weixia Huang

Reference: Freeman, L. C. (1977). A set of measuring centrality

based on betweenness. Sociometry. 40:35-41. *

Input Parameters: s e . ;
Number of bins: 10 . L _feageran s

umber of bins: 10
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Network Visualization:
Reduced Network After Pathfinder Network Scaling

/ '
LSt eMakeev, MA o i 'c ’ " . G";m'&
Ovicgek T 5 Aﬁ HE ., 1 0
o 5 ®hong H *
"’""'I‘s : J efevan
2 RN
. . _.ﬁ'ihu.u §
°r Y .?EEI'{
B A S R OPasoesabmasRe alorsto,V
. N Tt =
®0tva, 2N N e
- - pignani, A .
° I\"Ei!.!, A v N
SRR @Phoneo, L
- V4 _sBameemy, M
. » eBamat A
MST-Pathfinder Network Scaling was selected. . - .
Input Parameters: T vm——
Weight Attribute measures: SIMILARITY [ )

Edge Weight Attribute: weight
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Network Visualization:
Circular Hierarchy Visualization

Select Co-Author Network and run Blondel Community detection:

File DataPreparation Preprocessing | Analysis | Modeling  Visualizati Help
B Console ! Temporal L =0

= 1 :
Geospatial ’ = NEH- Worksh - |
Lo e Clisis ISt Filé waas sebeicted, 2 . Users\User\Desktop\10-NEH-A&H-Workshop\DVDAsci2\sample
Author(s): Micah Linnemeier P — o - ique IS Records
Implementer(s): Micah Linnemeier | Nebworks | Network Analysis Toolkit (NAT) on
Integ {s): Micah Li i ' | MetSciResearchers.isi
Documentation: | Unweighted & Undirected * e meraed
:..;arde;.l' bshis.indi d itylin=LoadData.ISILoadAr Weighted & Undirected » Clustering Coefficient
Ci\Users\User\Desktop\10-NEH-A&H-Workshop\DVD\sciZ\sample Unweighted & Directed ¥ Nearest Neighbor Degree
ometrics\isi\FourNetSciResearchers.isi | Weighted & Directed » Strength vs Degree
Loaded 361 recards‘ . D 151 Data: CAUsers\Use Degree & Strength
Removed 0 duplicate records. 4 [T7] 361 Unique ISI Rec Ayerage Weight vs End-point Degree
Author names have been normalized. - 2y e

'« Bxtracted Co-£ Strength Distribution

361 records with unique IS1IDs are available via Data Manager, £7] Author inform Weight Distribution
Wrote log to Randomize Weights
CA\U L DatalL Tempisidupli flogd773522398971021
37\3.;::"\ PR S e i = Blondel Community Detection

With parameter values | glondel Community Detection

This algorithm impl ts Blondel's ¢ ity detection
algorithm.
Weight | numberofcoauthoredworks v]
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Network Visualization:
Circular Hierarchy Visualization

I‘.iﬂﬂn:i.'
Sdarch & practice

Visualize resulting file using ‘VZsualization > Networks > Circular Hierarchy’
with parameter values

5| Circular Hierarchy

Provides Circular Hierarchy Visualization on the network.

Degree of Edge Bundling 0.75

Node Strength Column  |timescited - [@)
Level 0 |blondel_community level 0 |
Level 1 [blondcl_community_lml_l ']
Level 2 (blondel_community level 2 |
Level 3 (No Level - [ @)
Edge Weight Column [ numberofcoauthoredworks  ~| (@]

MNode Color Column ’numbem!‘works v]

Node Color Range IGmen to red v]
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Network Visualization:
Circular Hierarchy Visualization

Nodes that are interlinked/clustered e SSN
are spatially close to minimize the IR WRTE R e
number of edge crossings. T

Node labels, e.g., - & S

author names. // K%

Network structure I .2
using edge bundling.

Color coded clustet ———»

hierarchy according to 75 &N 7

Blondel community s '

detection algorithm. \\ 7 B Node Coloz

Note: — = “ w

Header/footer info, legend, and more meaningful color coding are under development.
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Paper-Citation Network Layout

To extract the paper-citation network, select the 367 Unigue 151 Records’ table and run
‘Data Preparation > Extract Paper Citation Network. *

The result is a unweighted, directed network of papers linked by citations, named
Extracted paper-citation network in the Data Manager.

Run NAT to calculate that the network has 5,342 nodes and 9,612 edges. There are
15 weakly connected components. (0 isolates)

Run ‘Awnalysis > Networks > Unweighted and Directed > Weak Component Clustering’ with
parameters

f ¥ Weak Component Cluster of 5151 nodes

:'3 Weak Component Clusterin -" &
& = . %, Weak Component Cluster of 38 nodes
Creates new graphs containing the top connected components. % Weak Component Cluster of 35 nodes
o
= - ‘Weak Component Cluster of 27 nodes
o
Nurmber of top clusters 10| A %%, Weak Component Cluster of 27 nodes.2
%, Weak Component Cluster of 15 nodes
[ Cancel

to identify top-10 largest components. The largest (giant) component has 5,151 nodes.

To view the complete network, select the network and run ‘VZsualization > GUESS”.
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General Network Extraction:

Weighted, Undirected Co-Occurrence Network

A B C D
1 Paper Authors References Year
2 P1 Al 1970
3 (P2 A2;AB P1 1980
4 P3 Al;A3 P1;P2 1990
5 P4 Al;A4;A5 P2 1995
6 PS5  AS5A6  P1;P2;P3;P4 1995 ®:
7 P6 AZAB P5 2000
®:s
Author co-occurrence network @rs
L ¥
[N Extract Network from Table _ % ®
Extracts a network from a delimited table
Column Name I;u_-':v.:rﬁ
@
Text Delimiter F]

*Vertices 6
1A1
2 A6
3 A2
4 A3
5A5
6 A4
*Edges 6
232
141
151
561
161
251
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General Network Extraction:

Unweighted, Directed Bipartite Network

A B © D L J%
1 Paper Authors References Year
2 1 A 1970 I
3 P2 A2A6 Pl 1980 .-f°
4 P3  ALA3  PLP2 1990
5 P4 ALA&AS P2 1995 @
6 PS  AS;A6  P1;P2;P3;P4 1995 \
7. P6  A2A6  P5 2000 ® Author \
- \
Paper N

Paper-author bipartite (2-mode) network

[N Extract Bipartite Network [

Extract a bipartite network from two columns in the table. If the column _.Pfl" @
values may list multiple entries, enter the spedal text which delmits
them.

First column [Paper
@
- .;3
Text Delmiter 13l H-

/

.A3

Object: |nodes based on -> || Property: |bipartitetype | Operator: | == w| Value: [Paper] ||

*Vertices 12

1 P1 bipartitetype "Paper"

2 A1 bipartitetype "Authors"
3 P2 bipartitetype "Paper”

4 A2 bipartitetype "Authors"
5 A6 bipartitetype "Authors"
6 P3 bipartitetype "Paper”

7 A3 bipartitetype "Authors"
8 P4 bipartitetype "Paper”

9 A4 bipatrtitetype "Authors"
10 A5 bipartitetype "Authors"
11 P5 bipartitetype "Paper”
12 P6 bipartitetype "Paper”
*Arcs

12

34

35

62

67

82

810

89

115

11 10

124

125 57

General Network Extraction:
Unweighted, Directed Network

A B C D ..452

1 Paper Authors References Year

2.1 A1 1970 . e

3 P2 AZA6 Pl 1980 e

4 P3  ALA3  PLP2 1990

5 P4 ALA4A5 P2 1995 ™

6 PS5  AS5A6  P1;P2;P3;P4 1995

7.P6  A2A6  PS 2000 ® Author \

B Paper
P [

\
Given a table, this algorithm a [ e
directed edge that starts ata %
column node. \

Source Column |Dauef \
Target Column Authors .p;'" =.M

[analysis Modeing Visualzaton R Help — .

Topcal b M .\'.
N . / P1
IR ok Ay ook 0 /
) Lnlhelavoutme' 4
Unweighted & Undirected DL .Aa
hel-S 46635 Weighted & Undirected » 20TE N 1AEATIE

Node Indegree

*Vertices 12

1 P1 indegree 0
2 Al indegree 3
3 P2 indegree 0
4 A2 indegree 2
5 A6 indegree 3
6 P3 indegree 0
7 A3 indegree 1
8 P4 indegree 0
9 A4 indegree 1
10 A5 indegree 2
11 P5 indegree 0
12 P6 indegree 0
*Arcs

12

34

35

62

67

810

82

89

11 10

115

12 4

125 54




General Network Extraction:

Unweighted, Directed Paper-Citation Network

A B C D .
*
1 Paper Authors References Year Vertices 6
2 1 Al 1970 1P1
3 P2 AZAG Pl 1980 2 P2
4 P3  ALAI  PLP2 1950
5 P4 AL;A4AS P2 1995 3P3
R 74
: ’ 5P5
6 P6
*Arcs
21
avena b, thsaoorit  ALCS from  papers to references 31
drected edge that starts a
surcecobn [pover — - 42
Target Column References : . P5 ) . P8 54
Text Delimiter I; . P g :f
.'. ; . P4 52
P2
65

1970 1980 1990

1995

2000
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General Network Extraction:

Unweighted, Directed Bi-Partite Network

A B C D
1 Paper Authors References Year
2 (P11 Al 1970
3 P2 AZA6 P1 1980
4 P3 ALA3 P1;P2 1990
5 P4 ALA4;AS P2 1995
6 P5 AS;AB P1;P2;P3;P4 1995
7 P6  A2A6 PS5 2000
I [
.P4 / _ .Ps
.P1 . r
aall
Extract a bipartite network .Pa ) P
alues may kst ent
Vi . y kst multiple .Pz
First column IPapef )
.P4
Second column References
Text Delimiter I: .P1

WRONG

*Vertices 11

1 P1 bipartitetype "Papet"

2 P2 bipartitetype "Paper”

3 P1 bipartitetype "References”
4 P3 bipartitetype "Papet”

5 P2 bipattitetype "References”
6 P4 bipartitetype "Paper”

7 P5 bipartitetype "Paper”

8 P4 bipartitetype "References"
9 P3 bipartitetype "References"
10 P6 bipartitetype "Papet”

11 P5 bipartitetype "References"
*Arcs

23

43

45

65

73

79

75

78

10 11




ISI Paper-Citation Network Extraction

A B [ D E
1 Authors Cited References Publication Year Title Cite Me As
2 AljAaz BENSMAN SJ, 1998, LIBR RESOUR TECH SER, V42, P147| BROI 2000 T1 A1, 2000, INT MICROBIOL, V10, P65
3 Al BENSMAN SJ, 1999, LIBR RESOUR TECH SER, V42, P147| BROI 2000 T2 A1, 2000, P ASIST ANNU MEET, V40, P486
4 A2|A3  GARFIELD E, 1985, ESSAYS INFORMATION S, V8, P403 | GILBE 2001 T3 A2, 2001, SCIENTOMETRICS, V60, P295
5 Al ASIMOV A, 1963, GENETIC CODE | LEDERBERG J, 1972, NATUI 2001 T4  Al, 2001, J INFORM SCi, V30, P119
6 AljA2 AVERY OT, 1544, J EXP MED, V79, P137| SMALL H, 1985, J INF 2002 T5 Al, 2002, INFORM TECHNOL LIBR, V22, P183
Arcs from references to papers—
in the direction of information flow

File | Data Preparation Preprocessing Analys

Remove ISI Duplicate Records % [ ] |

Remove Rows with Multitudinous Fields Fail
Extract Directed Network u WA, 2001, J Inform Sci, V30, P119
Extract Bipartits Network - W A-2000, Int Micrabiol, V10, P65 o
Extract Paper Citation Network
Extract Author Paper Network ]
W A1, 2002, Inform Technol Libe, V22, P183
|
|
A2, 2001, Scientometrics, V60, P295
=]
AT 2000, P AsistAnnu Meet, V40, P486
® [}
i

2000 2001 2002
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Tutorial Overview

12:30p Welcome and Overview of Tutorial and Attendees
12:45p Plug-and-Play Macroscopes, OSGi/CIShell Powered Tools
1:00p Sci2 Tool Basics
» Download and run the Sci2 Tool
» Load, analyze, and visualize family and business networks
» Studying four major network science researchers
- Load and clean a dataset; process raw data into networks
- Find basic statistics and run various algorithms over the network
- Visualize as either a circular hierarchy or network
2:30p Break
3:00p Sci2 Tool Novel Functionality
» Yahoo! Geocoder
» Evolving collaboration networks
> R-Bridge
4:00p Outlook and Q&A
4:30 Adjourn
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Yahoo! Geocoding and Geospatial Maps
bhttb:/ [ wiki.cns.in.edu/ display/ CIS HEIL L/ Yahoo+Geocoder

Address ===  Use Yahoo! Geocoder to identify Latitude, Longitude, Country, ZIP

Times Cited (T'C) W *

Aggregate TC over Country Restrict to US records
* Aggregate TC over ZIP
Use GoeMap (region) Use GeoMap (circle)

\ \4

World map colored by sum of TC per country US Map with circles sized by sum of TC per

(Choropleth Map) ZIP code, circle ring colored by count.
(Proportional Symbol Map)




=8| T.oad File with Address and Times Cited Fields

ch & practice

Load *yoursci2directory*/ sampledata/ scientometrics/ isi/ FourNetSciResearchers.isi’
using 'File > Load ...°
And file with 361 records appears in the Data Manager.

Duplicates were removed, author names normalized. Log file exists.

AQ2 > & S | Wuchty, S, Northwestern Univ, NW Inst Complex, Chambers Hall,600 Foster St, Evanston, IL 60202 USA.
AM AN AD AP AQ | AR AS AT AU AV AW AX

Publ Publish bli biis f Reprint Address Research . Research | Researche Special Iss Subject C: SupplemgTimes Cite
2006 BIOMED C MIDDLESEX HOUSE, 3| qumE. S, Northwestern Univ, NW Inst comgre:, Chambers Halll'lcrlhweslem Univ, NW Inst Complex, Ev Evolutionary Biology
2005 BLACKWEI 9600 GARSINGTON R, OXFORD OX4 Imﬁin ValueS niv Pittsburgh, Dept Pathol, Pittsburgh, Biochemi:Suppl. 1
2005 BLACKWEI 9600 GARSINGTON R, OXFORD OX4 2D0 n g niv Notre Dame, Dept Phys, Notre Dami Biochemi: Suppl. 1
2005 NATURE P MACMILLAN BUILDINE Barabasi, AL, Harvard Univ, Dana Farber Canc Inst, Ctr Canc Syst Bi Barvard Univ, Dana Farber Canc Inst, Ctr C Physics, Multidiscip’

7

]

0

2

2005 EDP SCIEN 17, AVE DU HOGGAR i Macdonald, PJ, Univ Notre Dame, Ctr Network Res, Notre Dame, Eniv Notre Dame, Ctr Network Res, Notre Physics, Multidiscipl 14
2005 NATURE P MACMILLAN BUILDINK Oliveira, JG, Univ Notre Dame, Ctr Complex Network Res, Notre | #niv Notre Dame, Ctr Complex Network F Multidisciplinary Sci 15
29

32

2005 NATL ACA 2101 CONSTITUTION b Oltvai, ZN, Northwestern Univ, Dept Pathol, Chicago, IL 60611 US. h n Univ, Dept Pathol, Chicago Multidisciplinary Sci
2005 NATURE P MACMILLAN BUILDINE AL, Univ Notre Dame, Ctr Complex Networks Res, Notre §niv Notre Dame, Ctr Complex Networks Multidisciplinary Sci

mmwmuam|u-p
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"% Relevant CIShell plugin

ch & practice

=§’C lSh Ql | Yahoo Geocoder £ Edt 4k Add ~ £F Tools -

Added by Aretha Alencar. last edited by Kavin Kumar Palanisamy on Feb 08, 2012 (view change)

Description

This algorithm converts place names or addresses into Latitude, Longitude co-ordinates. It accepts international addresses,
countries, States of United States of America and ZIP codes of United States of America. All co-ordinates are obtained by querying
Yahoo! PlaceFinder service. Internet access must be available during geocoding.

Pros & Cons

1. The performance is slower than the Geocoder and may vary due to the network latency since the queries are requested
through internet service. The benchmark test geocoded 470 unique locations per minute

2. Yahoo! Geocoder supports address geocoding with international coverage which is not supported by Geocoder.

3. To use Yahoo! Geocoder, user has to obtain an application id through Yahoo! registration. Save your application id and
provide it when requested by the Yahoo! Geocoder. Since each application id is allowed to geocode 50,000 locations per
24 hours, the user is encouraged to test on a small set of data first.

Applications

The plugin is useful for scientists who would like to visualize their data on a geographical map (geomap). User can obtain the
geographical coordinates (Latitude and Longitude values) and feed them to the visualization plugin.

bhttp:/ [ wikt.cns.in.edu/ display/ CLS HEIL L./ Yahoo+Geocoder
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i Geocoder

ch & practice

Please verify your
password
sers \katy \Dr 2-2
1] 361 Unique ISI Records
Are you protected? i
Create your sign-in seal.
£ |
Geocodes place names to geographic coordnates (Jatitudes and
longitudes) using Yahoo. Ensure your machine is connected to the Yahoo! ID
Internet. If you need to geocode more than a few entities, you may =
wish to obtain a Yahoo Place Finder application ID from sci2geo
http://developer. yahoo.com/geo/placefinder/ . You may oth
leave this field blank. ﬁgbm:m,mmpsﬁ. | Password
Performance may vary network latency; expect about 500 unique 1 1
g i [ Sci2geocoding
Yahoo Application ID | >UTmStS6ADBIWAT60XU_x2. 725GHz0kmg 0] Sign In
Place Type [acdress =| G]
| cant access my account | Help
Place Name Column  [Reprint Address =l 0]
i ?
. i o] Not sci2geo
Sign in as a different user.
[ |

21t KwqrV34HIII4_c2G51GcHgh6XkxUTm9tS6AbBIWdT60XU_x2.725GHz0kmg

67

Atool for

22 Geocode Address Using Yahoo! Geocoder

arch & practice

Result is a new file in Data Manager

[l s oo il
File DataPreparation Preprocessing Analysis Modeling Visualizaton R Help
ECcmolel =] = m

1 i ISI Data: C:\Users\katy\Desktop\TOOLS\s62-2011.09.30\sa

tation: http:/ /wiki.cns.iu.edu/display/CISHELL /Yahoo + Geocoder Bl E
= [T 361 Unique 151 Records

t Parameters:

Type: Address
‘alues are added to Latitude, Longitude, ZIP code, County, City ,State & Country,
espectively.

:esﬁ.l'v.geocoded 304 out of 351 locations to geographic coordinates —I
b4

with 7 new columns

BF BG | BH BI Bl | BK | BL
Latitude Longitude ZIP code County City State Country
42.02946091 -87.68838501 60202 Cook CourEvanston Illinois  United States

2 missing values, there is a total of 57 missing in these 361 records

42.34999466 -71.08765411 2115 Suffolk CcBoston  Massachu United States
41.70074844 -86.23918915 46556 St. Joseph St. Marys Indiana  United States
41.70074844 -86.23918915 46556 St. JosephSt. Marys Indiana  United States
41.89422607 -87.61901855 60611 Cook CoutChicago lllinois  United States
4170074844 -86.23918915 46556 St. Joseph St. Marys Indiana United States
41.70074844 -86.23918915 46556 St. JosephSt. Marys Indiana  United States
41.70074844 -86.23918915 46556 St. JosephSt. Marys Indiana United States
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: Atool for

o, A Console Messages

arch & practice

Load... was selected.

Documentation: http:/ /wiki.cns.iu.edu/display/ CISHELL/Data+Formats
Found old-style ISI/Web Of Knowledge file.

Found old-style ISI/Web Of Knowledge file.

Found old-style ISI/Web Of Knowledge file.

Found old-style ISI/Web Of Knowledge file.

Loaded 361 records.
Removed 0 duplicate records.
Author names have been normalized.

361 records with unique ISI IDs ate available via Data Manager.

Wrote log to C:\Users\katy\ AppData\Local\Temp\isiduplicateremoverlog2749984290663814202.txt

Loaded: C:\Users\katy\Desktop\ TOOLS\sci2-2011.09.30\sampledata\scientometrics\isi\ FourNetSciResearchers.isi
Yahoo Geocoder was selected.

Implementer(s): Chin Hua Kong

Integrator(s): Chin Hua Kong

Documentation: http:/ /wiki.cns.iu.edu/display/ CISHELL/Yahoo+Geocoder

Input Parameters:

Place Name Column: Reprint Address

Include address details: true

Yahoo Application ID: 21fKwqrV34HII14_c2G5IGcHgh6XkxUTm9tS6AbBIWdT60XU_x2.725GHz0kmg
Place Type: Address

Values are added to Latitude, Longitude, ZIP code, County, City ,State & Country, respectively.

No geographic coordinate found for location ""
Successfully geocoded 304 out of 361 locations to geographic coordinates

(from column "Reprint Address"). 57 rows had this location.
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Atool for

‘s | Aggregate by Country BT St o s
% >

d
Aggregate Data was selected. [N Aggregate Data x|
Implementer(s): Chintan Tank Aggregate data in the table based on a column,
Documentation: http:/ /wiki.cns.iu.edu/display/ CISHELL/Aggregate+Data

Input Parameters: Aggregate on column |Coun!nr '[ 0 |

Aggregate on column: Country

Delimiter for Country: | Times Cited I&.m "[ Q |
Longitude: AVERAGE i

Latitude: AVERAGE, Latitude [average -l @l
Times Cited: SUM m Gl

Aggregated by ": All rows of Latitude column were skipped due to no nog-mmll, nan-empty valu

Aggregated by ": All rows of Longitude column were skipped due to no noun-mnll, non-cmpty val - pelmiter for Country | | ol
Frequency of unique "Country" values added to "Count" column.
[0k cancel
E =

A B & D 4l A 8 | ¢ | D

1 Times Cited Latitude Longitude  Country 1| Times Cited [Latitude Longitude  Country iCount

2 7 42.02946091 -87.68838501 United States 2 14680 [41.10645f]  [-82.45309f] United States 194
3 0 3 1802 57
4 0 4 398 [47.506226f] [19.06482f] Hungary 14
5 2 42.34999466 -71.08765411 United States 5 101 |[37.25198f] [127.08451f] South Korea 4
6 14 41.70074844 -86.23918915 United States 6 18 [[32.08439f] [34.81297f] Israel 1
T 15 41.70074844 -86.23918915 United States 7 57 [46.768517f] [23.585135f] Romania 2
8 29 41.89422607 -87.61901855 United States 8 55 [47.06615f) [7.2015657f] Switzerland 2
9 32 41.70074844 -86.23918915 United States % 9 455 [47.977184f] [2.2232702f] France 12
10 7 41.70074844 -86.23918915 United States 10 92 [52.15457f]  [4.49463f) Netherlands 5
11 5 41.70074844 -86.23918915 United States 1 21 [49.944717f] [84.528114f] Russia 2
12 2 41.11500168 -85.73377991 United States 12 1112 [[41.545982f) [1.7138832f] Spain 13
13 10 47.50622177 19.06481934 Hungary 13 1381 [43.352654f] [12.727126f] Italy 46
14 44 41.70074844 -86.23918915 United States 14 188 [[-22.494667f] [-45.4818f] Brazil 3
15 0 47.50622559 19.06481934 Hungary 15 56 [51.24459f]  [10.360385f] Germany 2
16 19 41.70074844 -86.23918915 United States 14 0 1|70

-16.49901f] [-68.14626f] Bolivia




- e Aggregate + Geo Map (Colored-Region Annotations)

ch & practice

Also called ‘Choropleth Map’

Geo Map (Colored-Region Annotations) was selected.

Author(s): Joseph R. Biberstine

Implementer(s): Joseph R. Biberstine

Integrator(s): Joseph R. Biberstine

Documentation: http:/ /wiki.cns.iu.edu/display/ CISHELL/Geo+Map

Input Parameters: — (=]
Author Name: Katy Borner Visualization R l"eb
Color By: Times Cited General b I = |m | == |
Region Nam.e: Country derpozbil D \TOOLS\sa2-2011.09, 0\sa
Map: Countries = =
Color Range: Green to Red |-I
Color Scaling: Linear
Printing PostScript.. . £
Saved: C:\Users\katy\Desktop\geoMaps5661700855281902370.ps il
Creates a map with colored-regior Regions are identified
and colored according to columns in the input table. The table data can
be log-scaled before processing.
Save map to Desktop, view with PostScript viewer [Countres = @
or convert into pdf to view. Author Name [ Katy Borer By
Region Name |Country =] 2’
Vector format - can be rendered LARGE. ... = o
Color Scaling [Linear =l 2’
[FESTET]
71
How to Read the Geo Map Header and footer
with information

» when this map
was created, by
whom and using
what data set.

World Map with ~ o3
data ovetlay. *‘

Listing of map
type, author, and
parameters used.

Map legend with
color coding,

———» Geo Map (Colored-Region Annotation Style) —
Eckert IV Projection T ™
Feb 15,2012 | 08:51:44 AM |
Faty Bornes TN ]
et s A7 Tand § Cybtdbmmmtnns o Hasmmh s ot "
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Relevant Sci2 Manual entry

@ 5 2.4 Mapplng Sclentometrlcs (1SI Data)

y Ted Polley, oy Ted Polley

1 (view change

& Edit 9P Add ~ % Tools ~

5.2.4.1 Document Co-Citation

Scientometrics.isi
Time frame
Region(s)

Topical Area(s)
Analysis Type(s)

1978-2008
Miscellaneous
Scientometrics

Document Co-Citation Network

Scientometrics is a discipline which uses statistical and computatiqg
science. Here we use IS data from the joumal “Scientometrics” and
Awards Search

Download Scientometrics.isi. Load the file using ‘File > Load and lo
document co-citation analysis, as the scale is large enough that the
similarnity within the domain of scientometrics.

Goo Map (Circle Annotstion Strds
Eekent IV Pronermos
i 38, 3011 | 90047 AN

New 15l File Format

Web of Science made a change to their output format in September, 2011. Older versions of Sci2 tool may refuse to load these new

files, with an error like "Invalid ISI format file selected.”

bttp:

wikt.cns.in.edu/ display/ S CIZTUTORILAL/ 5.2.4+Mapping+S cientometrics+ %2815 1+ Data%29
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Sdarch & practice

Create Geo Map (Circle Annotations)
Also called ‘Proportional Symbol Map’

Restrict to 195 US records

Aggregate by ZIP code

x I_—A—I 8 C D e .
Aggregate data in the table based on a comn. 1 |[Times Citedjatitude  Longitude  ZIPcode Country  |Count
2 7| 42.02946091 -87.68838501 [60202)  United States| 1
Aggregae on cokam [ coce 3 @] [= 2|42.34999466 -71.08765411 [2115]  United States| 1
Times Gited fsen =] il 4 9438 | 41.70074844 -86.23918915 [46556]  United States 66
5 316 | 41.89422607 -87.61901855 [60611]  UnitedStates| S
Eldis [average | gl | 6 2|41.11500168 -85.73377991 [46566]  United States| 1
= L7 7| 42.17333984 -77.98394775 [14880] United States 3
S = = 9| 8 344169326782 -86.26696777 [46616]  United States| 1
7IP code il | 9 222| 45.42283363 -107.4489517 [} United States 5
10 2076 | 44.97523499 -93.23405075 [55455]  UnitedStates| 2
Delmiter for Country [1 i] n 18| 40.7978363 -77.86255646 [16802]  United States| 1
12 961| 42.3462112 -71.10174036 [2215] United States 16
[0k ] concel 13 208 | 42.35863495 -71.05670166 [2103]  UnitedStates| 5
14 13| 39.95228958 -75.16243235 [19107]  UnitedStates| 3
|15 601 | 39.95987072 -75.19809494 [19104] United States 40
16 0| 48.38810349 -115.5551758 [59923]  United States| 1
17 3| 3222143936 -110.9711914 [85701)  United States| 1
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- Atoal for

7| Create Geo Map (Circle Annotations)
Also called ‘Proportional Symibol Map’

Geo Map (Circle Annotations) was selected. x|
Author(s): Joseph R. Biberstine -
Implementer(s): Joseph R. Biberstine olicad m ::1 ‘::d!} aanull::b m\.l:: h’ the m":;:l o
Integrator(s): Joseph R. Biberstine Either or both kinds of coloring can also be disabled. The table data
Documentation: http:/ /wiki.cns.iu.edu/display/ CISHELL/Geo+Map ~ €8ch dimension can be log-scaled before processing.
US States s

Input Parameters: e I —I 2’
Longitude: Longitude Author Name | Katy Borner -9 I
Size Circles By: Times Cited
Color Circle Exteriors By: Count Latitude [Latitude 2 'el
Color Circle Interiors By: None (no inner color) -
Exterior Color Scaling: Linear BIELE ILongb.nde —‘v'l il
Exterior Color Range: Yellow to Blue Size Cirdles By |Tlr|cs Cited :-I ,g, |
Interior Color Range: Yellow to Blue
Size Scaling: Linear Size Scaling ILlnear ;I '9 I
Map: US States
Author Name: Color Circle Exteriors By |r-":"-""t _:I <@ |
Interior Color Scaling: Linear -
Latitude: Latirude sosees O =l o
Printing PostScript.. Exterior Color Range  [Gray to Black - |
Done. l _I e
Saved: C:\Users\katy\Desktop\geoUS.ps Color Circle Interiors By |Nune (no inner color) ;I ) |

: Interior Color Scaling L - |
Save ps file, convert to pdf, view. st - e

Interior Color Range [ e -] @

75
27 Create Geo Map (Circle Annotations)
Also called ‘Proportional Symbol Map’
Different parameter values result in different maps and corrsponding legends:
O O [ Geo Maps (cirdles) i x| 9 o 5
Creates a map with orde annotations. Cirdes are positioned, sized, and -
colored (inside and outside) accordng to columns in the input table., !
Either or both kinds of coloring can aiso be disabled, The table data for
each dimension can be log-scaled before processing.
Map |us states =l il
Author Name [ Katy Borner il
Latitude |Latitude =l i’
Longitude JLongitude =l 3'
Extenor Color (Lincar) Sae Cirdles By I"'I""ts Cited _ﬂ 2’ Exterior Color (Linear) Area (Lineas)
Count Sh!m ||-"¢!" ﬂ 3| Conat Temes Cited A
. P . Color Cirde Exteriors By [Count ~] ﬂ ! 5 “ Q\, 5438
o
Exterior Color Scaling  [Linear | i]
Exterior Color Range | Gray to Black =l i’
Color Circle Interiors By [None (no inner color) ﬂgl
Interior Cokor Scalng  [Lnear -l @
Interior CoorRange [T SN - © | 7




Tutorial Overview

12:30p Welcome and Overview of Tutorial and Attendees

12:45p Plug-and-Play Macroscopes, OSGi/CIShell Powered Tools

1:00p Sci2 Tool Basics

» Download and run the Sci2 Tool

» Load, analyze, and visualize family and business networks

» Studying four major network science researchers
- Load and clean a dataset; process raw data into networks
- Find basic statistics and run various algorithms over the network
- Visualize as either a circular hierarchy or network

2:30p Break

3:00p Sci2 Tool Novel Functionality
» Yahoo! Geocoder

» Evolving collaboration networks
> R-Bridge

4:00p Outlook and Q&A

4:30 Adjourn
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Sci2 Demo II:

Evolving collaboration networks

Tewlor sy Stonebrsker Disntzich Thiel Dalal oo
Chen
= Alkan - Larson Labow Fox
on  Wisnovsky Land obbins ko
Spalding Chuy Murzner C}emnsmwek. Hix
Hellersten
' France
Konstan ‘Woodnff Guimbretiers
Baldonado Ercegovec
Beny Olston DeLine : Schulman
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Core chi Gossweiler Fiohersan Gaget Nowedl
Riedl - oi Hearst Mork
il
Mackinly o Msintes - Tenasse
Shoop mnk
Fetzel Fakiarsad Hetzler
Pedersen Tanev Whitney
Lewis Chang Piralli Havre
Badro o o Pithow Fiso
ing g
Zhang Zelweger _— Fushall .
Ampin
Price: Stasko Kraamar - "THupk.ms ¢ Senn
[Callahan _
tukherea f ¢ ]
Jones Lucas
“Brown  Harold Weiset - Kelojechick
Johnson Card Disewrirs
Eagan G I Goldstein  G°MDe"g
J.' Wik Gershon
il
Ridin Shneiderman G Chush Mafts Swafioling
: Bederson ‘Wanenberg Jain = . Hao =
Frmann
Furnas Bose Williamson el Karpedjiev
North R Derthick
Zheng ) G Milash Ahlberg Seid! e Schneidewind Harmison
Kriegel
Zacks Bosn T Noth  ponce
Carr Beigel Wistrand Ben Moare
Ankarst
Legend Node Color Code Edge Color Code
g2 -0 E— Mapping the Evoluti f
~ Authors Ppin: e Evolution o
s 10.19 91-95
Node cove ~ Number of cigbons (1Y 20,20 m— 06100 pm— ‘Co-Authorship Networks
30-3% DN 0 Weimao Ke. Lalitha Visvanath & Katy Bomer
Edges ~ Co-autharship relations 40-40 InfoVis Lab @ Indiana University
Edge color ~ Year of first co-authorship to. mmmmmmmm Displayed Year: 1988 2004
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2 Rtool far o

@2 Evolving Collaboration Networks

B i furch & practice

Load isi formatted file

+ sci2-vl.5-alpha » ledata » scientometrics » isi v |44

Name Date modified Type Size

[Il"m droVespig Fre ].2_;[3 wHisld.isi

|| FourNetSciResearchers.isi 4 LaszloBarabasi.isi

] StanleyWasserman.isi 4| TestSPapers.isi
As csv, file looks like:

A | B | c | DF e T

_1 |Abstract Authors Authors (Full Names) 'Beginning Book Seri¢ Book Serie Cited Pate (
_2 |The systematic study of Colizza, V]Barrat, AlBarthelemy, M[Vespignani, A | 2015
3 |Uncovering the hidden r¢Colizza, VIFlammini, AlSerrano, MA[Vespignani, A 110
_4 |Computer viruses can s|Vespignani, A 135
_5 |Mapping the Internet geiDall’Asta, LIAlvarez-Hamelin, I|[Barrat, AlVazquez, AlVespignani, A | 140 LECTURE NOTES IN

Visualize each time slide separately:

[ -

M sl

19901991
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RAtoal for

orlcience Relevant Sci2 Manual entry

B i furch & practice

Hjoma £* Tools -
I aocichon 5.1.2 Time Slicing of Co-Authorship Networks (ISI Data)
# 2 Gefting Staried 76 Added by Ted Polley, last edited by Scolt Welngart on Mar 15, 2011 (vew change
¥ 3 Algonthms, Toals,
and Plugins AlessandroVespignan isi
& 4 Workflow Desi
58 k) plw:‘-' r;ﬂ'ﬂ Time frame. 1990-2006
= ample Wordlows
S 5.1 Indvidual Level Region(s) Indiana University, University of Rome, Yale University, Leiden Unharsity, Inemational Center for Thearstical Physics,
Studies - Micro University of Paris-Sud
é;.;:‘;zzg‘: Topical Areals) Informatics, Complex Network Science and System Research, Physics, Statistics, Epidemics
Putlication, and Analysis Type(s Co-Authorship Netwark
Funding Profiles hysie Typels) i
ol Ong )
Researcher The Sci* Tool supports the analysis of evohang networks. For this study. load Alessandro Vespignani's publication history from ES1. which can be
(Endiote and downloaded from Thomson's Web of Science or loaded using ‘File > Load” and following this path-
NSF Data} AsitAlessandroVespignani isiusing ' Slice the data into five year intervals from 1390-2006 using Preprocessing > Temporal > Slice Table by Time' and the
5.1.2 Time Skcing following parameters:
ol Co
tietworks 05 |=|| [ Stice Table by Time [Py =s=)
Data) |
5.1.3 Funding |I Shce a table into groups of rows by bme.
Profiles of Three -
Researchers at [ - |
Pfeipizin| Date/Time Column | Publication Year ||!
(NEF Data) |i'
5.1.4 Studying Date/Time Format.  yy .
Four Major Net3d —
Ressarchers (1SI Stice [nto [vews - L-J
Data) —
 52instution Level How Many? 5 |!,
Studies - Meso —
& 5.3 Global Livel From Tine 19%0 |&)
Studies - Macro |i
& 5 Sample Scence e 2008 i |
Studies & Online - |
< latre |
Serdces 4 Cloms S |u
& 7 Edending the Sa2 1 i =1
Tool 171 Align With Calendar -1
® § Relevant Datasets 1
and Toals i WeekStartsOn [Sundwy =] |!
9 References { e | e |

bttp:/ [ sci2.wiki.cns.in.edu/ 5.1.2+ Time+S licing+of+ Co-Authorship+Networks+ (1S [+Data)
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Slice Table by Time

ch & practice

Fore A’
% Slice Table by Time Lo | E
Slice a table into groups of rows by time.

Date/Time Column |Publkau'on Year > |

Date/Time Format  yyyy | ﬂ‘

Slice Into | Years el
"Slice Into” allows the user to slice the table by days, weeks, months, quarters, years, decades, and

How Many? 5 centuries. There are two additional parameters for time slicing: cumulative and align with calendar. The
former produces tables containing all data from the beginning to the end of each table's time interval, which

From Time 1290 can be seen in the Data Manager and below.

= D 101 Unique 151 Records
slice from beginning of 1990 to end of 2006 (101 records)
slice from beginning of 1990 ta end of 2001 (65 records)
| slice from beginning of 1990 to end of 1996 (26 records)
{71 slice from beginning of 1990 to end of 1991 (4 records)

To Time 2006
[¥] Cumulative?

[7] Align With Calendar

Week Starts On Lsﬂ'i The latter option aligns the output tables according to calendar intervals

ISREE] 101 Unique ISI Records
gf slice from beginning of 2002 to end of 2006 (36 records)
+1 slice from beginning of 1997 to end of 2001 (39 records)
+| slice from beginning of 1992 to end of 1996 (22 records)
+1 shice from beginning of 1920 to end of 1991 (4 records)

Choosing "Years™ under "Slice Into” creates multiple tables beginning from January 1% of the first year. If
“Months® is chosen, it will start from the first day of the earliest month in the chosen time interval

bttp:/ [ sci2. wiki.cns.in.edu/ 5. 1.2+ Time+Shicing+of+Co-Authorship+Networks+ (1S1+Data)

s Atoal for

22 Visualize Each Network, Keep Node Positions

ch & practice

1. To see the evolution of Vespignani's co-authorship network over time, check ‘cummulative’.

2. Extract co-authorship networks one at a time for each sliced time table using 'Data
Preparation > Extract Co-Author Network', making sure to select "ISI" from the pop-up
window during the extraction.

3. To view each of the Co-Authorship Networks over time using the same graph layout,
begin by clicking on longest slice network (the 'Extracted Co-Authorship Network' under 'slice
Sfrom beginning of 1990 to end of 2006 (101 records)’) in the data manager. Visualize it in
GUESS using 'Visualization > Networks > GUESS'.

4. From here, run 'Layont > GEM' followed by 'Layout > Bin Pack'. Run 'Script > Run Script
..."and select ' yoursci2directory/ scripts/ GUESS [ co-author-nw.py'.

5. In order to save the x, y coordinates of each node and to apply them to the other time
slices in GUESS, select 'File > Export Node Positions' and save the result as
"yoursci2directory/ NodePositions.csv'. Load the remaining three networks in GUESS using the
steps described above and for each network visualization, run 'File > Import Node Positions'
and open "yoursci2directory/ NodePositions.csv'.

0. 'To match the resulting networks stylistically with the original visualization, run 'Seripz >
Run Seript ..." and select "yoursci2directory/ seripts/ GUESS / co-author-nw.py', followed by 'Layout >
Bin Pack', for each.

bttp:/ [ sci2.wiki.cns.in.edu/ 5.1.2+ Time+S licing+of+ Co-Authorship+Networks+ (1S [+Data)
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=cifice of hcience
S#farch & practice

Vespignany A
Piatioren L
® vepassa u ° '“::.:_’.-'
.I wneeren, @ Dengsin R
® waiu
1980-1991

[ ]
““::‘.r'-s._..

1580-2001 1990-2006

bttp:/ [ sci2.wiki.cns.in.edn/ 5.1.2+ Time+ Slicing+of+ Co-Authorship+Networks+(1S1+Data)
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Relevant CIShell plugin

resdarch & practice

Slice Table by Time £ Tools ~

&ClIShel
3

var L IDNE

Added by Argtha Alencar. last edited by Ted Polley on Jan 12, 2011 (yiew changa)

Description

Shice Table By Time is an algonthm to chop a table up into new tables, based on a dateftime column. |t takes the column with the date/time data, a string
describing the format of that column. the intervals that the data should be sliced into. whether or not the slices are cumalative, whether or not the slices should be
aligned with the calendar, and what day the week is considered to start on (which only matters if the slices are aligned with the calendar) as parameters

The column to use for dateftime values should have a langlc value for each row of data. It is used by the algosithm to choose which slice(s) the row should end up
in_ In order to d what d s reps d by that row, you must provide the al-gmhm with a descnptive format, in lha second pammm For instance,
a four digit year would be represented by yyyy (the default value) See hitp oda-t nel al/DateTimeFormat himl for
details of all the vanous formatting options.

The next dropdown has the available intenals to shce the table into. These include millisecends, seconds, minutes. hours, days, weeks, fortnights, manths,
quarters, years, decades, and centunes. A future version of the algorithm may include the ability to select how many of these intenals should be grouped together
at once

The checkbox that follows determines if the shces will be cumulative. I the slices are not cumulative, every row in the onginal table is in one and only one resulting
shce. However, if the shces are cumulative, evary row in the onginal table is in the slice it is for and every slice for a period after that

The checkbox that follows determines if the shces will be aligned with the calendar. For instance. if the first row is for June Tth, 2006 and yearly slices are chosen,
then the default behaior will be to have the first slice be from June Tth, 2006 to June 6th, 2007. However, if the slices are aligned with the calendar. the first slice
wall be from January 1st, 2006 to December 31st, 2006. Alignment does not affect the output for intervals of fortnights, quarters, decades, or milliseconds

I the slices are aligned with the calendar and are weekly, then the day the week stars is used to determing how they are aligned

Pros & Cons

The output of the slice algorithm is in separate tables, so a longitudinal analysis will require working with each slice separately, which can be awkward. There will
likely be future versions of the time slice algonthm that annctate the onginal table with the slice the rows belong to

Applications

When doing longitudinal analysis of data, it can be useful to consider it in chunks, such as to calculate how statistics have changed over time. Altematively. only a
particular time pericd might be of interest, and this algorithm can extract it from data for a karger time range

Implementation Details

This algonthm uses the Joda Time kbrary ively, which provides signil improved capabili P to the default Java algonthms for dates and
times

bttp:/ [ cishell.wiki.cns.iu.edn/ Slice+ Table+by+ Time
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Tutorial Overview

12:30p Welcome and Overview of Tutorial and Attendees
12:45p Plug-and-Play Macroscopes, OSGi/CIShell Powered Tools
1:00p Sci2 Tool Basics
» Download and run the Sci2 Tool
» Load, analyze, and visualize family and business networks
» Studying four major network science researchers
- Load and clean a dataset; process raw data into networks
- Find basic statistics and run various algorithms over the network
- Visualize as either a circular hierarchy or network
2:30p Break
3:00p Sci2 Tool Novel Functionality
» Yahoo! Geocoder
» Evolving collaboration networks
» R-Bridge
4:00p Outlook and Q&A
4:30 Adjourn
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R-Bridge

Download edu.in.cns.r_0.0.1.jar from Additional Plugins wiki page at
http://sci2.wiki.cns.iu.edu/3.2+ Additional+Plugins
Or copy them from the DVD or memory stick.

Run ‘R > Create an R Instance’ parameter should be the path to the directory on your
computer that contains Rgui.exe. Results in an ‘R Instance’ object in the Data
Manager.

To send a table from the data manager to an R Instance object, select the table and
the R Instance object together then run R > Import Table Into R’. Select ‘R > Run
Reui’ and the table is available in the R environment using the variable name you
specified as a parameter to the Import algorithm.

To pull back data from an R Instance object to the Data Manager, select the R
Instance object and run R > Export Table From R’. Choose the name of the
variable from the dropdown list.
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4:00p Outlook and Q&A
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New Sci2 Release Preview

The next Sci2 release will become available in April 2012. It will add

VVVYVYVYYVY

New ISI file format reader

Publication and funding database support

Improved geographic map legend

New 10-year Global Map of Science (formerly UCSD Map)
R-bridge

Gephi.org graph layout tool
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Topic Mapping: UCSD Science Map

Science Map via Journals for FourNetSciResearchers.isi ==

314 joumnal references matched out of 361 found. gy e

These 314 references ase associated with 13 of 13 disciplines of science and 255 of 5534 research specialties in the UCSD Map of Science. 3

Data:
WoS and Scopus for 2001-2005, 7.2 million -
papers, more than 16,000 separate journals,
proceedings, and series

Similarity Metric:
Combination of bibliographic coupling and
keyword vectors

Number of Disciplines:
554 journal clusters further aggregated into 13 main |-
scientific disciplines that are labeled and color

"5 Science Map = _ i S
Locate the journals from a table on the UCSD Map of Science coded ina mEtaph0r|Ca| way, €.9., Medicine is
. y blood red and Earth Sciences are brown as soil.
Journal column Joumal Name {(Abbreviated) | ’?J —
Dataset display name  FourMetSciResearchers.isi @
Cancel )
= .

How to Read the UCSD Map

;-.fut Map vis Journals for NIHATTSA Publicssens on / B
UCSD Science Map

with data overlay. ——> |

Circle of non-located,
e.g., ‘Unclassified’
records.

b Header and footer with
Map legend of ———» | & o B information when this
> map was created, by

whom and using what

data set.

circle area size
coding

Listing of all data ——»
records organized into
UCSD science areas.

Listing and circle of
non-located, e.g.,
Y ‘Unclassified’ records.
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Computational Scientometrics
Cyberinfrastructures

..~ Scholarly Database: 25 million scholarly records
'*Q’* http://sdb.slis.indiana.edu

g»%,% VIVO Research Networking
& http:/ /vivoweb.org

Information Visualization Cyberinfrastructure
http://iv.cns.iu.edu

Network Workbench Tool & Community Wiki
http://nwb.cns.iu.edu

B Science of Science (Sci?) Tool
P http://sci2.cns.ju.edu

gv““b% Epidemics Tool & Marketplace
q% Forthcoming

R ClShel!

Alliance 91

SQ& SCHOLARLY DATABASE

Scholarly Database at Indiana University
bitp:/ | sdb.wiki.cns.in.edu

Supports federated search of 25 million publication, patent, grant records.
Results can be downloaded as data dump and (evolving) co-author, paper-citation networks.

&3 |SCHOLARLY DATABASE @; QFHOI ARLY DATABASE

Cytrermtrastrucsass fo2 Hatwork Bence Coster, 5115 lmbians Ursrermty, Beceungiun

4 far Center, SLIS, Indiana Univernity, Bloomington

y T A AAREES

Search | Edit Profile | Admin | About | Logout

U User Non-IU User
1F rushiple tarrns are artared in & fisld, they are
Bagpeye Search autematically combired using ‘OR". S0, "breast
cancar’ matchar any recerd with ‘braast’ or “cancer in
e Creators: Sl
{ toon ] e AND batwaan combing with
Tithe: ARDS. Than “brn a4t AND ¢ euld saly mateh
racoeds that contain both
Abstract: |FNA
Double quetation can be ured to match compound
Full Test: term ratnavas raconds wth
First Year: | 1538 'I
Last Year: | 2008 "l Tha impartance of & partioular tarm in & quary can b
increntad by putting & v aftar the

cormasnd to matching the te

2y P
(] SeHooL oF LieRaRy @
- AN [HFORMATICN SCIEHCE

Register for free access at http://sdb.cns.iu.edu
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cholarly Database :: Results - Mozilla Firefox

Fle [Edt View Higtory Bookmarks Tools Help

W‘ C' 30 o) | L] | htpisssdb.sis.indiana.edufsearchiresuksrq=("artiicial inteligence”) 17 = '|marknv:kbmid1 P

2] Most Visted @ Getting Started . Latest Headines | | Hotel Kenigshof - Bod...

ﬂe'
|

R

A &

SCHOLARLY DATABASE]

Cyberinfrastructure for Network Science Center, SLIS, Indi Uni ity, Bl ington

-

Search ‘ Edit Profile ‘ Admin

Browse Results

[
About ‘ Logout |

Results 1 through 2

MNext>>

E Authors /

‘Your search returned 13,231 results in 0.295 seconds. | W/

0.

© ;

vi.- .

Total results per database: NIH: 2,103, Medline: 10,235, USPTO: 279, NSF: 614,

Year Tite

Medline LaCombe
Medline
Medline Schritt

Adlassnig

Medline Adlassnig

Medline Goldenbe

and

Medline Touretzky

g

1987 Artificial intelligence.

1989 Artificial i i @: expert sysh

1990 [Artificial intelligence in dentistry ]

2002 Artificial-i i e ted

Score (outof
5.71)

5.71
5.71
5.71

5.60

1980 Artificial intelligence.

1980 Artificial intelligence.

4.86
4.86 93

arly Database = Download - Mozilla Firefox

e Edt Wew Hatory Tock Heb

2l

artiicial AN U7 E,]-|mmm )

Q- ¢ X L [l

L) Most Visted e Getting Started . e

SCHO

Download Results

T selast all downloads,

Medline Database: =

LA

Cyberinfrastructure for Network Science Center, SLIS, Indiana University, Bloomingion

r T T
Search | EditProfie | Admin | About | Logout

Download |2Ell301] records starting st record |1 from the folloving databases:

RLY DATABASE]

Since March 2009:
Users can download networks:
Co-author

Co-investigator
Co-inventor

Patent citation

and tables for

burst analysis in NWB.

T Madiine MaSH heading table 3 Faverk
T Madline MasH qualifier table Flo 0 20w JobeHew, l & i
T Madiine author table B Back = Ll ] Search || Folders -
™ Madiine co-author table (nub format) [T e 0 J |;D hH |
T Madline master tabla Lo idiess | or\sampledatatscentometricalsch H =l
2| Hame l
IO e
-
T i master table (2 e ey ! suthor_table.csv | 960 KB
NEE Databias FokderTonk ) Medine_co-suther_table_(rwib_format).csv 627¢8
29 Make a new folder S Medine_master_table.csv 13,986...
T WSF cosinvestigator table(avb format) IE ) Publih this folder tothe EMedine_MesH_headng table.csv 3,453¢B
T s master table [ Web E‘mm_muﬂu:mle.m £53KB
USPTO Database: |~ SN aster_table.cov S5
Other Places i BENsF _co-nvestigator_table_(mwb_format).csv 19KB
™ usPTo Patent Cosparation Traaty table I SNsF _master_table.csv 1,303 K8
T usPTO agent table 1) scentometrics B uUsPTO_ co-inventor_table_(rmb_format).csv 18KB
™ usoTo assignes table I () My Documents Euspro_sgent _table.cov 20k8
I UsPTO citation table trub Format) 0 & My Network Places gmo'm table.csv Z3KB
™ uspTo daims table B2 @iumo-m t-aua_(mb Format).csv 7248
T USPTO corinvantor table (nwb format) [T @uwolma- rable.csy 69KB
T usPTo invantor table B2 Details 2 gmo:m_r;.ﬂm).:w 308 KB
T useTo mactar (burst format) 0 sdb E)UsPTo_master_table.csv kB
I usPTO master table (0 Fie Folder — EJuseto_patent_Cooperation_Treaty_table.csv 2KB
_Download | 0, 2008, 120mm o =la | o

| Done

A
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Enabling a National
Network of Scientists

VIVO: A Semantic Approach to Creating a National Network
of Researchers (http://vivoweb.orq)

» Semantic web application and ontology
editor originally developed at Cornell U.

* Integrates research and scholarship info
from systems of record across
institution(s). : e

- Facilitates research discovery and cross- -
disciplinary collaboration.

« Simplify reporting tasks, e.g., generate __ s
biosketch, department report. - = e

Pacumy ant et

Funded by $12 million NIH award.

Cornell University: Dean Krafft (Cornell PI), Manolo Bevia, Jim Blake, Nick Cappadona, Brian Caruso, Jon Corson-Rikert, Elly Cramer, Medha Devare,
John Fereira, Brian Lowe, Stella Mitchell, Holly Mistlebauer, Anup Sawant, Christopher Westling, Rebecca Younes. University of Florida: Mike Conlon
(VIVO and UF PI), Cecilia Botero, Kerry Britt, Erin Brooks, Amy Buhler, Ellie Bushhousen, Chris Case, Valrie Davis, Nita Ferree, Chris Haines, Rae Jesano,
Margeaux Johnson, Sara Kreinest, Yang Li, Paula Markes, Sara Russell Gonzalez, Alexander Rockwell, Nancy Schaefer, Michele R. Tennant, George Hack,
Chris Barnes, Narayan Raum, Brenda Stevens, Alicia Turner, Stephen Williams. Indiana University: Katy Borner (IU PI), William Barnett, Shanshan Chen,
Ying Ding, Russell Duhon, Jon Dunn, Micah Linnemeier, Nianli Ma, Robert McDonald, Barbara Ann O'Leary, Mark Price, Yuyin Sun, Alan Walsh, Brian
Wheeler, Angela Zoss. Ponce School of Medicine: Richard Noel (Ponce PI), Ricardo Espada, Damaris Torres. The Scripps Research Institute: Gerald
Joyce (Scripps P1), Greg Dunlap, Catherine Dunn, Brant Kelley, Paula King, Angela Murrell, Barbara Noble, Cary Thomas, Michaeleen

Trimarchi. Washington University, St. Louis: Rakesh Nagarajan (WUSTL PI), Kristi L. Holmes, Sunita B. Koul, Leslie D. McIntosh. Weill Cornell
Medical College: Curtis Cole (Weill PI), Paul Albert, Victor Brodsky, Adam Cheriff, Oscar Cruz, Dan Dickinson, Chris Huang, Itay Klaz, Peter Michelini,
Grace Migliorisi, John Ruffing, Jason Specland, Tru Tran, Jesse Turner, Vinay Varughese.

UF | Clinical and Translational
Science Institute

UNIVERSITY of FLORIDA 96




University of Florida

How do you want to compare? Comparing Grants of Organizations in University of Florida s s
: s 3 Enabling a National

by Grants - 0 Network of Scientists

Who do you want to compare?

Search

Records 1-10 of 30 First « Prov Next » Last

Entity Labed Grant  Entity Type
Count
¥ Continuing 562  UF Department, Agent,
Education Hon-Acadernic Departmant,
Department
4| Forida Museum 203  Museum, Agent

of Natural History
Total Number of Grants
¥ Coege of 166  Agent, UF College, College
Agricultural and You have s
Life Sciences

7 of a maximum 10 org

Y| CoBege of 103 Agent, UF College, College .
Engineenng
L
¥ EvelynF.and 64 UF Center, Agent, Conter
Wiliam L.

McKnight Brain
Institute of the

University of Y.
Florida
4
4 international 54 UF Department, Agent,
Center Non-Academic Department, s
Department
4| Florida SeaGrant 44 UF Center, Agent, Center ¥ B

[save 2 v [ciear

Temporal Analysis (When) Temporal visualizations of the number of papers/funding

award at the institution, school, department, and people level 7

Home People Organizations Research Events

versity of Florida @
487 publications activity acros
| 554 Sub-Disciplines

4 scientific sub-discipiines B

1-13 01554 First «Pre o+ Las
e Math and F
Sub-Disciplines #ol [ - ,
pubs.  activity _J f'
Pest Management Science  24.2 50 | it
J
arch 19.1 19
131 2
Clinical Cancer Research 12 2
Pain 120 25
12 23
1.1 2
0.9 2 /
— Earth Sciences ——
103 21
10.2 2
Top 280 dscipines sh
g 19

mapped 14.55% of 3,346 publications

Topical Analysis (What) Science map overlays will show where a person, department,
or university publishes most in the world of science. (in work) 98




Conlon, Mike

Associate Director and Chief Operating Officer

Co-Author Network (GraphML File

This may cnly be & smal

person's total work

Interact

Hover over a

Retresh

Sort alphabetica

Enabling a National
Network of Scientists

1Y FArT

point publication

Mike

—

Network Analysis (With Whom?) Who is co-authoring, co-investigating, co-inventing

with whom? What teams are most productive in what projects?
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National Researcher Networking
Visualization 1.0
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Uap data €2011 Europa Technologies, Geocentre Consuling, NEGL MapLink, Tele Atias -

Québec

o

o F

X
Maryland

District of
Columbia

+|J
% New

I Maine

Rhode Island

Connecticut

New Jersey,
Delaware

& cyberinfrastructure for
Seey NETWORK SCIENCE CENTER
. cns.iu.edu

P Data Types
Check in the boxes next to the data
types you'd like to see displayed on the

map.

~
7>

2))

<
& ™ O People

M [ Publications
B < Patents

M /\ Funding

M O Courses

Brunsw_%
{ | Nova
| Scotia

Vermont
New Hampshird
Massachusetts

System Types
Elsevier SciVal Experts

Stanford CAP

Timeline

North
Atlantic
Ocean

Jun, 2011
Jun, 2011
>

Jun, 2011

I =
Play Pause Stop

Terms of U

Geospatial Analysis (Where) Where is what science performed by whom? Science is
global and needs to be studied globally.
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Borner, Katy
Download Data

General Statistics Enabling a National
e Network of Scientists

c«amn;nmt — | General Statistics
S * 30 publication(s) from 2001 to 2010

¢ 80 co-author(s) from 2001 to 2010

Co-Author Network

Save as Image (PNG file)

Tables
* Publications per year

=1 =1 .

Tables

Co-authors

Yom

36 publication(s) from 2001 to 2010 : 3
: Enabling a National
Network of Scientists

80 co-author(s) from 2001 to 2010

Year Count Co-Author(s)

2001 1 Chen C

2002 3 Chen C.; McMahon T., Feng Y
2003 2/Chen C.; Boyack KW

2004 17 Sengupta A ; Penumarthy S.; Thakur S.; Sooriamurthi R.; Maru J.T.; Shiffrin R.M.; Mane I; Moor KA ;

-0 WNNN N

Co-author network

<xml version="1.0" encoding="UT ">
<graphml xmlns="http://graphml.graphdrawing.org/xmlns"

xmlns:xsi="http: //vwv.v3. org/2001 /ALSchema-instance”

%xsi:achemalocation="http: //graphml, graphdraving, org/xnlns

htep: //graphml . graphdrawving. org/xmlns/l.0/graphml . x3d">
<key id="label" for="node” attr.name="label” attr.type="string” />
<key id="number of authored works" for="node" attr.name="number of_ suthored works" attr.type="int" />
<key ids"num unknowm _publication” for="node” attr.name="num unknowm _publication” attr.types="int” />
<key id="num_latest publication” for="node"” attr.name="num latest publication” attr.types="int" />
<key id="latest_publication” for="node” attr.name="latest publication” attr.type="int" />
<key id="profile url"” for="node"” attr.name="profile url"” attr.type="string” />

'
2
3
4
5
6
7
8
vl
o
15

=

Save as Image (PNG file)
Publications per year , see top file.

Co-authors Count
i 1

Ben-Miled Z
Blackwell A
Boyack K'W.
Bozicevic M
Brodbeck D.
Burkhard R.A
Chen C




Cytoscape

7 3
ggg C I 11621 CIShell - Add new Plugins, e.g., Cytoscape

Adding more alyout algorithms and network visualization interactivity

via Cytoscape http://www.cytoscape.org.

Simply add org.textrend.visnalization.cytoscape_0.0.3.jar into your /plugin directory.
Restart Sci2 Tool.

Cytoscape now shows in the Visualization Menu.

S2 Sci2 Tool

i14 Data Manager |
| ape was salacted, il = E' 151 Data: C:\Documents and Settings|borner
| Integrator(s): TexTrend Consortium (http://www.textrend = £:51 361 Unique ISI Records
Universitas Press) = %", Extracted Co-Authorship Network
Reference: Cytoscape Consortium (http://www.cytoscapeX o = =

r| Author information
C:\DOCUME~1\bornerk|L OCALS~1|Temp|CIShel-Session-6885247 765800266799 StaticExecut able
{Runner-20687 1 8271 48887037 Talgorithm >echo off

cytoscape, Cytoscapelnit[INFOJ: Cytoscapelnt static initialization

cytoscape. Cytoscapelnit[INFO]: Parent_Dir: C:\Documents and Settings\bornerk.cytoscape
(created,

Select a network in Data Manager, run Cytoscape and the tool will start with this
network loaded.
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& Cytoscape Desktop (New Session)

File

5 QaQ =

| Control Panel

! Edge-weighted Force directed (BioLayout) »

Data Panel

HOW Ee

o |

Node Attribute Browser | Edge Attribute Browser = Network Attribute Browser

Mo

Welcome to Cytoscape 2.6.2 Right-click + drag to Z00M Middle-chick + drag to PAN e
32 1Sl osGi/cishen Adoption
A4 D1 I P

USA

A number of other projects recently adopted OSGi and/or CIShell:

> Cytoscape (http:/ [ cvtoscape.ors) Led by Trey Ideker at the University of California, San Diego is
an open source bioinformatics software platform for visualizing molecular interaction
networks and integrating these interactions with gene expression profiles and other state data
(Shannon et al., 2002).

»  MAEuviz (bttps:/ [ wiki.ncsa.uinc.edu/ display/ MAE / Home) Managed by Jong Lee at NCSA is an
open-source, extensible software platform which supports seismic risk assessment based on
the Mid-America Earthquake (MAE) Center research.

Europe

Y

Taverna Workbench (bttp:/ [ taverna.org.nk) Developed by the myGrid team
(http://mygrid.org.uk) led by Carol Goble at the University of Manchester, U.K. is a free
software tool for designing and executing workflows (Hull et al., 2006). Taverna allows users
to integrate many different software tools, including over 30 000 web services.

Hungary supports natural language processing (NLP), classification/mining, and graph
algorithms for the analysis of business and governmental text corpuses with an inherently
temporal component.

»  DynaNets (hitp:/ [ www.dynanets.ors) Coordinated by Peter M.A. Sloot at the University of
Amsterdam, The Netherlands develops algorithms to study evolving networks.

> SISOB (bttp:/ [ sisob.lec.uma.es) An Obsetvatoty for Science in Society Based in Social Models.
As the functionality of OSGi-based software frameworks improves and the number and
diversity of dataset and algorithm plugins increases, the capabilities of custom tools will expand.

> TEXTrend (btip:/ / texcirend.orz) Led by George Kampis at E6tvés Lorand University, Budapest,
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g‘é’gc |SHelll osGi/cishell-Powered Tools Support Algorithm Sharing

Common algorithm/tool pool L]
Easy way to share new algorithms
Workflow design logs
Custom tools

@ 1s
O cs
O Bio
@ SNA
Phys

Converters
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Downloads for NWB Tool Releases

DBy ok Workbeneh Tool )
http://nwb.slis.indiana.edu it
o 89,559

The Network Workbench (NWB) tool
supports tesearchers, educators, and
practitioners interested in the study of
biomedical, social and behavioral science,

!Hom People Rezearch Publications

physics, and other networks.

In February 2009, the tool provides more 169
plugins that support the preprocessing,
analysis, modeling, and visualization of
networks.

ol . _ s B 3
Dec-06 Dec-o7 Dec-of Dec-og  Augto
More than 50 of these plugins can be Hawes & Updited W03 B 0.7 + post
applied or were specifically designed for " Knouiadia Rasearch & Cresmve ACOAY: 3 v0.4 B 08+ pre
S&T Studies. (websag accessed S109) . v0.5 . 0.9 + pre
* 32309100 bela S Released W 0.6 B v1.0.0 + pre

It has been downloaded more than 65,000
times since December 2006.

Summary

Network Workbiench: A Large-Scale Networ
Toolkt for Blomedical, Social Science and A
evaluate, 3nd operate 8 unigue distributed,
stale network analysis, modeling, and visua
(NWE). The emvisioned data-code-computin)
more

ite this projec]

= 1.23.09 Ann Mecranie's ulorial abstract for 5
009

| Total # of Downloads

= 11.4.08 Two NWE Pls featured in “Connec
~ 2008, Anna Maria

il —Thip
Talas,

Director. Australian Broadcasting Corporation, Lid

[YouTube] [Full Video (00ME)]

E] Ll
See more documentation

Getinvolved

Herr 11, Bruce W., Huang, Weixia (Bonnie), Penumarthy, Shashikant & Birner, Katy. (2007). Designing Highly Flexible and Usable
Cyberinfrastructures for Convergence. In Bainbridge, William S. & Roco, Mihail C. (Eds.), Progress in Convergence - Technologies for Human

Wellbeing (Vol. 1093, pp. 161-179), Annals of the New York Academy of Sciences, Boston, MA.
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fruits

Computational Economics o '@'
e table ol
Does the type of product that a fishing A . g
country exports matter for e ol 1§ e %
subsequent economic performance? @ - yl '/ & torestand paper
. ® @ Products
vegetables ‘ ot 1 4o » m
ERENVARS NP
J cereals
: WO\ AID
- ®
coffee and cocoa F y

products

C. A. Hidalgo, B. Kiinger,

A.-1.. Barabdis:, R. Hausmann : 3 P l—a //ﬂ
: 3

vehicles

(2007) The Product Space . machinery
» L]
Conditions the Development T =
garments T
of Nations. Science 317, R -l
482 (2007). o
metallurgy $o —~_» electronics
g A -
e cobar (Learner Clasadeanon) D o J . L
O . ] textiles ‘q/ . [®fiiesi
PRI IR ' S
FATRET] LN
ik coben {pecasenty) nacde wze (worid tmdo [thosands of USSH
o000 .+.000 w il s\ A
PEEE RRLER animal
agriculure chemicals
Fig. 1. The product space. (A} Hierarchically clustered proodmity (4) matrix  with their prodmity value. The sizs of the nodes are proportional to world
representing the 775 SITC-4 product classes exported in the 19982000  trade, and their colors are chosen fing to the classifs introduced by
period. (B) Network representation of the product space. Links are color coded  Leamer. 109
Second sight
Computational Social Science e
Studying large scale social Power struggle
networks such as Wikipedia How o You keep tackofthebubblng
marss of information that s Wikipedia?
This chaotic-looking masaic i one

attempt to show which lopics ae

Second Sight: An Emergent Mosaic of
Wikipedian Activity,
The NewScientist, May 19, 2007

network dynamics, coinciding with this
week's Inteinational Workshop and

| Conbesence on Network Science

{ In Bloomington.




Computational Epidemics
Forecasting (and preventing the effects of) the next pandemic.

Epidemic Modeling in Complex: realities, V. Colizza, A. Barrat, M. Barthelemy, A.V espignani, Conptes Rendus
Biologie, 330, 364-374 (2007).

Reaction-diffusion processes and metapopulation models in heterogeneous networks, V.Colizza, R. Pastor-Satorras,
A.Vespignani, Nature Physics 3, 276-282 (2007).

Modeling the Worldwide Spread —s|mpact or Air Travel on Globall Spread OFf Infechous Diseasess—
of Pandemic Influenza: Baseline ' ' - e

Case and Containment Interventions,

V. Colizza, A. Barrat, M. Bartheleny,
A.-J. Valleron, A.Vespignani,
PloS-Medicine 4, 13, 95-110 (2007).

duelipeust of noden
Irrigneson syin.

?’F’ “"i
*Forecasts OF THE Next Pundemic Influenza *

¥ wrigriry il iy i o
i tha 33k ) vmmmp g

Fla sl s rnges
b
et

Hogmas [Vatearm] o Pog Spwing

Computational Proteomics

What relationships exist between protein targets of all drugs and all
disease-gene products in the human protein—protein interaction network?

* =" asseag

@ © 2007 Nature Publishing Group

Yildriim, Mubammed o, 50
A., Kwan-1I Goh, ':'.u: =3 -
Michael E. Cusick, L2 N

[ =
Albert-1aszld Barabasi, o i:‘"
and Marc Vidal. (2007). L
Drug-target Network.

Nature Biotechnology
25 no. 10: 1119-1126.

oA} T .
- . rs ¥
P . =
e, .
w - (L]
P " s v
s .
o I S L X

Figure 2 Drug-target network (DT network). The DT network is generated by using the known associations between FDA-approved drugs and their target
proteins. Circles and rectangles correspond to drugs and target proteins, respectively. A link is placed between a drug node and a target node if the protein
is 2 known target of that drug. The area of the drug (protein) node is proportional to the number oﬂnmlhal lhe drug hu (the number of drugs umlﬂl
the protein). Color codes am given in the legend. Drug nodes (circles) are colored ing to their A Chemical Classifi and the
target proteins (rectangular boxes) are colored acconding to their cellular component obtained from the Gene Ontology database,
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File | C

B¢ I".

R Help
=0

Welco

il Data Manager-:

visualization of epidemic processes. -~

The Epif he NIH RM-07 d. Th
man] File (Compartmental Modeling] Networks _Simulation i o, i sh 004 award. The
Create a compartmental model
The Epi : hintan Tank, Joseph Biberstine,
Chin Hu | Wel Edit compartmental model ng, 3

| EpiC uses the Cyberinfrastructure Shell {http.ffcislwll-org] developed at the Cyberinfrastructure for

Network Science Center (httpy//ens.slis.i

I [T E— R

Please cite as follows: i
| EpiC Team. (2009). EpiC Tool. Indiana Univer§|

Exact
Network

Single-Population

‘ ! Algorithm Name

& Scheduler|
Remove From List | [/ R completed automatically |R; all cor [Vﬂuﬁuhon] Reaelp
| Line Graph
Date Time

% Complet
TPEYR] Help

@ e & cenren @Cl* e IPowered

Create an R Instance
| Run Rgui
.! Import Table Into R
| Export Table From R
—_—
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National Office for

Home Publicat

Project leader
IGeorge Kampis, PhD, DSc

an integrated TEXTrend toolkit and

University Press Ltd.

TEXTREND: Development of a business and governmental decision support
toolbox using trend- and text-analysis tools

The two interconnected objectives of the TEXTrend project are (1) the creation of

demonstrative applications in varied fields
decisions, exemplified by use cases.

TEXTREND
and Technology

s Programme

analysis

download o«

leader
service basis, and (2) the elaboration of rese
of business and governmental team

ROOLkit trend = UnIVErsity v

Team leader: Gegrae Kampis, PhD, DSc
Gydirgy Fabri, PhD, CSc
Sandor Sods, PhD

T‘n|§.an ﬁ-.-.;;'.g ﬁﬁr‘ , -

HCCI Research Institute of Economics
and Enterprises

Team leader: [stvdn Jdnos Téth, PhD
lbgnes Czibik, MSc

lagnes Makd, MSc g
Tamas Uhrin, MSc

Zoltan Varhalmi, MS¢

Glia Computer Consulting Ltd.
Team leader: Attila Bencsik, MSc
Rita Adam, MSc

Henriett Baai, BSc

[stwan Graf, MSg

Zalan Szakolezi, BSc LT,

Created at
http:fftagcrowd.com

Created by
www . wordle.net

text}end

TEXTrend adds R bridge, WEKA, Wordij, CFinder, and more.

See the latest versions of TEXTrend Toolkit modules at
bhitp:/ [ textrend.org/ index.php2option=com _contente>view=articled>id=47 & Itemid=53
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%géc IS h el l CIShell - Integrate New Algorithms

About the Cyberinfrastructure Shell Learn More...
The Cyberinfrastructure Shell (CIShell) is an open source, community-driven platform for the + CiShell Papers
integration and utilization of datasets, algorithms, tools, and computing resources. Algorithm - MMM
integration support is built in for Java and most other programming languages. Being Java based, * Algorthms
it will run on almost all platforms. The software and specification is released under an Apache 2.0 * Plugins (coming soon
License. + Misc. Tool m ion
« CIShell Web Services (coming soon)
CIShell is the basis of Network Warkbench, TexTrend, Sci® and the upcoming EpiC tool. « Screenshots

CIShell supports remote execution of algorithms. A standard web senvice definition is in

development that will allow pools of algorithms to transparently be used in a peer-to-peer, client- Getting Started

server, or web front-end fashion.
. mentation loper R 1L
* Download

CIShell Features

Getting Involved...
A framework for easy integration of new and existing algorithms written

in any programming language » Contact Us

Using CIShell, an algorithm writer can fully concentrate on creating their own algorithm in whatever
language they are comfortable with. Simple tools are provided to then take their algorithm and

CIShell Developer Guide is at http://cishell.wiki.cns.iu.edu

Additional Sci2 Plugins are athttp://sci2.wiki.cns.iuv.edu/3.2+Additional+Plugins
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=§?C IS h el l CIShell — Customize Menu

> The file Yourtooldirectory/ configuration/ defanlt_menn.xm!’ encodes the structure of
the menu system.

» In NWB Tool, the Modeling menu (left) is encoded by the following piece of

xml code:

|g =
Network Workbench Tool
File  Preprocessing Arabysis  Visualzation  Scientometnics
B Consale | Fandom Graph
e fNETwoTe workos Wiatts-Strogate Small Warld

irvestigators are Dr. b
Wasserman, and Dr. § Barabisi-Albert Scale-Free

i

The WWB toolwas g ="

Tank, Jazeph Bibersti Cherd I
Terkhorm,Heng Zhan . 1
Vespignani, and Katy Hypergrid

PRU
Network Warkbench i d
Science Certer (hitp: TARL

= | <top_menu name="mModeling">

et omno @) " nenu pid="edu. 1u. nwb. mode]ng. erdosr andongraph”/>
hitpclinwbalisindisn  Evohang Network (Weighted) <menu pid="edu.iu. nwb.modeling.smallworld"/>

<menu pid="edu.iu.nwb.modeling.barabasialbert”/>

<menu t¥pe-"break"/>

<menu pid="edu.iu.iv.modeling. p2p.can.canalgorithm"/>

<menu pid="edu.iu.iv.modeling.p2p. chord.chordalgorithm"/>

<menu pid="edu.id. iv.modeling. p2p. hypergrid. Hypergrid"/>

<menu pid="edu. iu. iv.modeling. p2p.pru.Prualgorithm”/>

<menu t¥pe-"break"/>

<menu pid="edu.iu.iv.modeling.tarl.Tar1algorithm"/>

<menu type="break"/>

<menu pid="edu. iu. nwb.modeling. discretenetworkdynamics. onDAlgorithm” />

<menu type="break"/>

<menu pid="edu. iu.nwb.modeling.weighted. evolvingnetwork" />
</top_menu>
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Need Help? Ask an Expert!

SN i L N U S RS R "‘ﬁl T Ll 7o' O 5
C‘( W o e p “'F’; !‘\“» iy | L @ . & "
pL A L °

N A Tool for Science of Science Research & Practice

Ask An Expert

(if you need to report a bug for the Scr tool instead 2)

Project Title |

Types of Analyses ™ Temporal (When) View sample question:
™ Geospatial (Where) y o >
™ Topical (What)
™ Modeling (Why) (Will open in new tab.)
™ Networks (With Whom?)

HERE

Levels of Analyses [ picrofndividual (1-100 records)
™ MesolLocal (101-10,000 records)
™ Macro/Global (> 10,000 records)

Intended Users ‘

Insight Needed ‘

https://sci2.cns.iu.edu/user/ask.php
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If you enjoyed the tutorial, please thank Andrea Scharnhorst, Albert
Merofio Pefiuela, Jeannette Haagsma, Anja de Haas, Nick Jankowski, Sally
Wyatt; US side: Chin Hua Kong, Joseph R. Biberstine, Samantha Hale

There will be a Sci2 Tutorial for Science Policy Makers
at OECD, Paris on April 13, 2012.

Q&A

Please complete the Post-Tutorial Questionnaire
so that we can further improve these tutorials.

k %k %k

Bug reports and all comments are welcome.




cyberinfrastructure for
ETWORK SCIENCE CENTER

All papers, maps, tools, talks, press are linked from http://cns.iu.edu

CNS Facebook: http://www.facebook.com/cnscenter
Mapping Science Exhibit Facebook: http://www.facebook.com/mappingscience




